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Introduction 

This in-depth documentation of best-practices provides useful information that will help anyone 

interested in deploying Advance Steel have successful results. 

Chapter I – Installation and Deployment 

Basic Installation Notes 

Advance Steel can be installed: 

 Standalone 

 Together with AutoCAD through a Bundle installer. 

Settings available during the standard installation process: 

A) Product language and content 

o Sets the Advance Steel user interface language.  

o Adds the specific country content to the database – preferred sizes, detailing resources, symbol 

configuration, specific default settings, etc. 

 

The language and content of an Advance Steel installation can be changed only by reinstalling the program. 

To change the language and content of an Advance Steel installation: 
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 Uninstall Advance Steel. 

 Back-up or remove the relative content folder of Advance Steel, located, by default, in 

c:\ProgramData\Autodesk\Advance Steel 2017\ 

o If Advance Steel was used and configurations were made, then database backup is required, so 

after the reinstall, those databases and configuration files can be used. 

o If the language and content change occurs due to a missed step during the installation process, 

then is recommended to fully remove the folder with no backup. 

 Install Advance Steel. 

 

B) Add additional drawing styles configuration 

 

 
 

Advance Steel will install a default content database that matches the language and content selection 

made in the previous step. If additional drawing styles, from other countries, are required by the 

customer, during installation those can be added from this page. Once installed, they will need to be 

activated from the Country setting dialog. 

Note: By default, Advance Steel does not install any additional drawing styles. They need to be manually 

selected. 

 

C) Add/remove the Advance Steel desktop shortcut 

For the Bundle installer of Autodesk Advance Steel and AutoCAD, the installation process also offers all 

the AutoCAD specific settings. Furthermore, the AutoCAD version installed by this Bundle package can be 

used standalone, or together with another AutoCAD Vertical / AddIn. 

Installation paths set during the installation process 

The installation framework offers two configurable paths: 

1. System file path 
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In this location Advance Steel installs the system files necessary for the program to work. Those 

need to be on the local drive. 

 

 
 

2. Content folder path 

This is the relative folder where the Advance Steel content specific to the language installation is 

stored. This folder can be set anywhere on the hard drive, or in a Mapped Network drive. 

Important! The folder where the Advance Steel content is stored needs to have full Read/Write 

user permissions. The databases, even when they are read-only, need to write a temporary file in 

the specified location. 
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Use of Deployments 

The deployment functionality of the Advance Steel installation frameworks offers the option to create a 

deployment. This is done by a system administrator, who creates a local installation package of Advance Steel.  

This installation is predefined, so when it is used to install Advance Steel it skips any configuration steps done 

during the installation.  

A deployment: 

 Ensures that all Advance Steel versions installed by a company come with exactly the same settings, 

avoiding any errors that can force a reinstallation of Advance Steel. 

 Means a faster installation process, by not prompting users to make content and path configuration 

required by the company. 

 Can be installed with a Silent mode, with a minimalistic graphic user interface.  

 Can store license specific settings (e.g. Server name, product key) for faster deployment. 

 Can be stored on a local path or a USB Dongle, eliminating the need of internet connection during 

Advance Steel installation.  

Creating a Deployment 

1. Click on Create Deployment in the installation framework.  
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2. Set the following fields as required by the company: 

o Name 

o Path 

o Run installations in silent mode – removes the need to click the Next button on an installation 

framework, and runs a silent install that only display a progress bar.  

 



                                                                                                  Advance Steel Implementation Guide                                                                                                                   
 

9 
 

3. Set up the installation requirements on the next page, such as License Information, Language and Content 

and Custom Settings. 

 

4. Create the deployment. 

The deployment will be created in the path set at step 2.  

The deployment can be used by clicking on the shortcut with the name set at step 2, inside the folder. 

Both installation packages of Advance Steel (with and without AutoCAD) offer the Deployment feature. For 

the Bundle installation (AutoCAD + Advance Steel), the Deployment will also include the AutoCAD 

installation, offering a one click installation workflow for the whole package. 

Installation specific information 

 Only one Advance Steel language content version can be installed at a time, on a computer. A second 

install will not be allowed by the installation framework. 

 The Advance Steel installation can contain all the other languages detailing specific configuration, 

using the Country AddIn functionality. 

 Installing Advance Steel and AutoCAD requires an “Admin” Windows account.  

 UAC (User Access Control) – Windows security functionality – is triggered during install, and needs to 

be allowed for the installation to proceed. 

Uninstall Advance Steel 

Uninstalling Advance Steel can be done using the Autodesk Uninstall Tool application, or using the Windows 

Control Panel - Programs. 

 

During Uninstall, only the system files are removed, while the databases and any other content are kept in their 

default folder.  

Notes: 
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 If no prototypes, BoM on drawing files, symbols or other custom files were modified or added in the 

Advance Steel installation, after uninstalling, the backup databases and prototypes will be moved to a 

specific folder named UserDataBackup, and the installation BoM on drawing files, symbols etc. are 

removed. 

 

For this scenario, where the user di not modify the content files, and only modified databases, the backup 

after uninstalling Advance Steel consist in: 

o Backing-up the UserDataBackup folder and “User2” folder 

o Deleting the other folders 

o After installing Advance Steel, restoring the databases from those two folders over the existing 

ones. 

 If files were modified in the installation, after uninstall, the entire content in the 

ProgramData/Autodesk/Advance Steel 2017 folder is kept intact. Uninstalling the software will not 

remove any files, in this case. 

 Back-up the whole folder after uninstalling the software if a different language needs to be installed. 

 During Uninstall, ensure that AutoCAD, Advance Steel and Management Tools are closed. 

 

Why to perform an uninstallation? 

  

Often the Uninstall is required if the language and content selected during Advance Steel installation do 

not match the requirements (e.g.: The user wants Advance Steel U.S., but installed Advance Steel English 

International) 

 

In this case, the steps are: 

- Uninstall Advance Steel. 

- Delete the entire ProgramData folder content. 

- Reinstall Advance Steel. 

If databases were modified on the “incorrect” installation, then those databases need to be backed up and 

replace after installation. Please note that if the database contains translation values (for example the 

AstorSettings database storing the Defaults), restoring the database means that the names in the 

interface will be kept (for example, keeping an AstorSettings from a German installation after installing 

the U.S. installation means that the default values from Management Tools will keep the German names). 
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Advanced Installation Notes 

Deploying Advance Steel for a company also requires other specifics, in addition to the actual installation of the 

program system files and having it working. 

An important aspect is the network database and content sharing workflow. 

Advance Steel uses many databases and content folders to store all the country specific settings, and the user 

customizable settings. To ensure that all stations within a company use the same settings in a project, sharing the 

content and having all stations use it is a common practice. 

The following example explains how and why Advance Steel accesses its content, and how this content can be 

effectively shared and reused. 

Advance Steel Databases and Content 

Below is a list that describes the role and location of all the Advance Steel databases. 

1. c:\ProgramData\Autodesk\Advance\Data\ 

 AstorProfiles2017.mdb - Steel profiles, user sections, compound profiles used by transfer mapping 

 GTCMapping2017.mdb – Import/export steel section mapping rules 

2. c:\ProgramData\Autodesk\Advance Steel 2017\Kernel\Data\ 

 AstorDetailsBase.mdb – generic detailing settings, used by the Drawing Style Manager. It doesn’t 

contain any specific user settings; it does contain language specific names reused in the Drawing Style 

Manager.  

 AstorKernelEnvironment.mdb – contains the token internal definition. It doesn’t contain any specific 

user settings; it does contain language specific names reused in the Drawing Style Manager and Bill of 

Material editor. 

 AstorProject.mdb – contains the external Bill of Material templates (edited using the Bill of Material 

editor), Advance category (default templates that can’t be edited by the user). 

 AstPrjStdDB.mdb and model.mdb – specific internal Advance Steel databases that do not contain any 

content. 

 

3. c:\ProgramData\Autodesk\Advance Steel 2017\Steel\Data\ 

 AstCrtlDb.mdb – contains most of the translation strings visible in the Advance Steel interface. It 

doesn’t contain any specific content. 

 AstorBase.mdb – contains most of the base content definitions of Advance Steel, like: 

 Bolts 

 Anchors 

 Materials 

 Coatings 

 Name mapping 
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 Model roles 

 Symbol definitions 

 AstorDetails.mdb – contains all the drawing styles and processes available with the Advance Steel 

installation, and are accessible from the Advance category. There is no available content for the user 

to modify in this database. 

 AstorRules.mdb – contains all the steel connection library settings, as well as internal tables used by 

Advance Steel for steel connections. 

 AstorBitmaps.mdb – stores a set of picture assignments, internal database that doesn’t contain any 

user specific settings. 

 AstorGratings.mdb – contains all the Grating definitions, both user and out-of-the-box. 

 AstorSettings.mdb – contains all the default settings configured through Management Tools / 

Defaults. 

 AstorProfiles.mdb – Steel profiles, user sections, compound profiles used by Advance Steel 

 

4. c:\ProgramData\Autodesk\Advance Steel 2017\StressAnalysis\Data\ 

 AstorJointsCalculation.mdb – various design specific values used by the Advance Steel steel connection 

design calculation tool, with engine available for both AISC and EC3 standards. The table contains all 

design parameters, accepts steel section specific values, found in the section definition tables from 

AstorProfiles.mdb database. 

 

5. c:\ProgramData\Autodesk\Advance Steel 2017\User2\Data\ 

 AstorAddIn.mdb – a very important database that contains most of the customer configuration. In this 

database, Advance Steel stores all the drawing styles, drawing processes and external bills of materials 

from the User category.  

 

Location for other content specific to Advance Steel 

 c:\ProgramData\Autodesk\Advance Steel 2017\Shared\ConnectionTemplates\ - default folder to store the 

Custom Connections made for Advance Steel. 

 

 c:\ProgramData\Autodesk\Advance Steel 2017\Shared\StandardPartTemplate\ - default folder to store the 

Standard Part Template .dwg files used for numbering. 

Both folders described above are not mandatory to store their specific content, and the customer can choose 

any other path on the hard drive or in the network for those two types of content and configuration files. 

 c:\ProgramData\Autodesk\Advance Steel 2017\Shared\Support\ - main content folder 

Most of the Advance Steel .dwg specific content is located in this folder. The root of the folder contains all the 

custom hatches, fonts and auto-lisp routines installed and used by Advance Steel. 

Subfolders: 
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o BOMTemplates – all Bill of Material on drawing templates, inserted and used on drawings to 

generate the Bill of Materials. New templates made by the customer need to be added to this folder. 

o Prototypes – all Advance Steel prototypes used during automatic detailing and by processes. New 

prototypes made by the customer need to be added to this folder. 

o Symbols – all symbols used by Advance Steel connections and detailing functionalities. 

o Templates – default folder for the .DWT file used as a template file for new Advance Steel 3D models.  

  

What content files do I need to share to allow multiple users/stations to have the same Advance Steel 

settings and environment? 

Because not all the databases and content folders mentioned above contain specific customer settings (are 

internal databases, or contain settings that cannot be edited), they should not be the scope of the database share 

process, and they should remain local, associated to each station Advance Steel installation. 

The databases that need to be shared to ensure the same Advance Steel settings are: 

AstorProfiles.mdb – to share all the custom profiles and section added or modified by the company 

GTCMapping2017.mdb – to share the import/export mapping rules for steel sections, if import/export is used with 

custom mapping by the company. 

AstorBase.mdb – an important database to share, as it allows the access to the same libraries of bolts, anchors, 

materials, etc. 

AstorGratings.mdb – shares all the new and modified gratings 

AstorSettings.mdb – an important database to share, as it contains all the default values that are used throughout 

Advance Steel, from modeling to detailing.  

AstorRules.mdb – an important database to share, as it stores all the steel connection library entries, allowing the 

use of identical steel connections settings to minimize the chance of errors during connection design. 

AstorAddIn.mdb – shares all the custom made drawing style, processes and bills of materials.  

Content and support files, like prototypes and BoM on drawing templates do not have the option to be shared in 

the network, so in order to ensure a good accessibility by all the users, those files need to be copied in each station 

content folder.  

Network Requirements to Share Databases 

Sharing databases on a network folder requires specific network permission requirements for Advance Steel to 

work. 

When databases are accessed by Advance Steel, the folder they are located in needs to have full read and write 

permissions. Users (Windows access user) running Advance Steel on their machines need to be able to fully write 

information in those folders. Restricting them would lead to the improper functioning of Advance Steel (even if the 

software will eventually start, it is not recommended to work with it as this may lead to issues). 
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When mapping a network folder that contains the databases to Advance Steel configuration file, it is 

recommended to use a Mapped Network Drive. 

How to restrict the multiple stations connected to the same databases to modify their content? 

A common request that concerns sharing databases is the user control over their content. In addition to having all 

Advance Steel users within a company share the same settings, to ensure the project coherence, project 

administrators also want the content to be controlled and modified only from an administrator level. To achieve 

this, the database can be set on a read-only status: 

2. The network folder is set to full read-write permissions. 

3. Database .mdb files are set by the system administrator to Read-only and locked for others users to 

restrict them from modifying it. 

Advance Steel will work properly with the databases set on read-only. Each setting will be read, used, but once it’s 

modified – it will not be saved in the database or even used locally, within the running Advance Steel session.  

The folder that is shared does not need to have any type of sub-folder structure. All sharable databases can be 

placed in the same folder, as the paths changed for them are independent from one another.  

Network deployment of database configuration in Advance Steel 2017 

Starting with Advance Steel 2017 the registries are no longer present, so all the steps required in the past no 

longer apply. The access to all databases is now stored in a common place – an editable and sharable xml file. The 

entire process of changing the mapped network address where the databases are placed is described in the 

following topic: FAQ: How to use databases from a network computer? 

 

Alternative method to configure Advance Steel to use shared databases and content folders 

from a network address 

The previously method involves using the content and database files on a server computer. 

Due to how the Advance Steel database engine uses databases, those folders cannot be write protected, which 

may not be according to company policy. 

An alternative method is to copy the files during startup on the local drive and use them, instead of accessing the 

files from a shared database. 

Using this method, Advance Steel will work with full local files and, because those files are copied during each 

startup, the system manager can ensure that the configurations are up to date and no user modification can affect 

them. 

This method allows the shared folder to be read-only. 

See the steps to apply this deployment strategy. 

http://windows.microsoft.com/en-us/windows/create-shortcut-map-network-drive#1TC=windows-7
http://help.autodesk.com/view/ADSTPR/2017/ENU/?guid=GUID-ABCEF7F2-A124-4410-80AB-648736D80B5B
https://knowledge.autodesk.com/support/advance-steel/learn-explore/caas/CloudHelp/cloudhelp/2016/ENU/AdvSteel-FAQ-List/files/GUID-D839F65F-F21A-4A49-B3F8-D05C7312CC47-htm.html
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License installation Notes 

The licensing mechanism used by Advance Steel is common to all Autodesk products. 

Information about setting up Stand-alone installations and network servers can be found online: 

 Autodesk Stand-Alone Licensing Guide 

 Autodesk Network Licensing Guide 

Working with an Advance Steel project located on a network address 

A common workflow is to store the Advance Steel project – model, drawings and all the other associated 

deliverable files on a network computer, shared with multiple users, allowing them to work simultaneously on the 

drawings, by opening them directly – without having to copy the model from one computer to another. 

To ensure a consistent functionality of Advance Steel while working with the project on a network address, and 

preserve the connection between the model and the drawing – which allows the update of drawings from both the 

model (Document Manager) and the drawing (Force Update, Create Section cut, change scale, etc.), a set of steps 

are required: 

1. The Advance Steel project needs to be copied as a whole, without altering the folder substructure where 

Advance Steel stores the drawings, NC files, BoM lists and so on.  

This includes: 

 The model DWG file. 

 The MDB database with a name identical to the model DWG name (if available). 

 The folder with the same name as the model DWG. 

o The folder should be copied as a whole. 

There is also the option to generate the deliverables (detail drawings, NCs, BoMs) directly on the network 

folder. This requires having only the model on the network folder, opening it and generating the files. 

 

2. Network share folder permissions: The entire model and its associated documents need to have FULL 

READ/ FULL WRITE permissions.  

 

3. Access the shared network folder using the Windows Mapped Network Drive functionality. This 

functionality allows any Windows machine that is connected to a network to map a specific folder, shared 

on the network, to a local drive. This means that a network shared folder address, such as: 

http://help.autodesk.com.s3.amazonaws.com/sfdcarticles/kA230000000tblXCAQ/adsk_slg.pdf
http://help.autodesk.com.s3.amazonaws.com/sfdcarticles/kA230000000tblXCAQ/adsk_slg.pdf
http://images.autodesk.com/adsk/files/adsk_nlg0.pdf
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\\networkcomputer\sharedFolder\, will be accessed through a local drive such as Z:\, which will be 

available in My Computer next to the computer local drives. 

With this set, opening the Advance Steel project on each local computer will be done though this relative 

path (e.g. Z:\SampleModel.dwg), allowing Advance Steel to fully preserve its document registration 

mechanisms, in a similar way to how it works when the project is on a local drive. 

 

Setting up a mapped network drive 

The sample below is created for a Windows 7 environment. For other Windows versions the workflow is similar, 

even if some dialogs can have slight modifications in design/content. 

1. Open Computer by clicking the Start button, and then clicking Computer. 

2. Click on Map network drive in the top side menu bar. 

 

3. Select an available Drive, and insert the Network folder path where the shared Advance Steel project 

exists. 

4. Click Finish. 

Once finished, the mapped network drive can be found in Computer, next to the local drives. You can access it 

similarly to a local drive, so any workflows that involve opening, copying and using Advance Steel with the project 

located in it will remain the same as if the project were located on the respective computer.  

 

 
 

Chapter I A – Initial Setup and Content Migration 

Initial Setup 

Author 

file://///networkcomputer/sharedFolder/


                                                                                                  Advance Steel Implementation Guide                                                                                                                   
 

17 
 

An important aspect of every Advance Steel configuration done at the interface level is the Author. This represents 

an attribute associated to each database configuration that ensures a correct transfer of settings from one version 

to another and also differentiates the user configuration from the out-of-the-box settings.  

Setting up the Author 

- Go to Management Tools > Options 

- Use the Create New author command to create the author entry, and select it. 

 

- Close the Management Tools to apply the change. 

Setting up units 

Advance Steel offers independent unit settings for: 

- The 3D model 

- Output drawings 

- Management Tools 

The units can be set differently in each case, and drawings can be outputted from a model to any units. 

For example, drawings can be created in both metric and imperial units, while the model is created in imperial 

units and remains unmodified.  

Set up the 3D model project units: 

When starting a new project in Advance Steel, using the New command, there are two templates to choose 

between: 



                                                                                                  Advance Steel Implementation Guide                                                                                                                   
 

18 
 

 

- ASTemplate.dwt - > imperial units based project. It will come with a generic set of imperial length and 

weight units (inches, pounds). 

- mm_ASTemplate.dwt -> metric units based project. The generic units will be millimeters and kilograms.  

The two templates are identical in all aspects, the only difference being the units. 

The example above is from an English US installation, where the default template “ASTemplate.dwt” is an imperial 

one, while the alternative is a metric template. 

For a metric based installation of Advance Steel, like English UK or German, the default template ASTemplate.dwt 

will be a metric template, while the alternative will be an imperial template inch_ASTemplate.dwg. 

ASTemplate.dwt is, by default, used during Advance Steel startup when launching it from the desktop icon. 

Additional modifications to the project units 

Templates used to start the project contain a set of generic configurations for the units. For any changes, the 

Project Data configuration dialog needs to be used and modified once the drawing is created and saved, as a 

startup file for the new project. 

To access the Project data dialog, click the Project settings… button, located on the Home tab > Settings panel: 

 

Any changes made to the units, will be saved and used only in the current project. Another new project started 

with the New command will not recall the settings made in the previous one. 
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Drawing output units 

When generating drawings from Advance Steel, the units that will be used to display dimension line values, or to 

give weight or length information in tokens, will be read from the prototype file. You need to change the units, 

using the prototype editor, before the drawing is created. 

Management Tools units 

All the configuration options located in Management Tools (Defaults, Bolts, Anchors, etc.) use a different unit 

configuration, specific to Management Tools, independent from the model settings. 

The units can be modified from the Units Selection tab: 

 

Content Migration 

When the current Advance Steel version is upgraded to a newer one, all the user content needs to be migrated 

through a series of steps described in this Advance Steel user settings migration process. 

To ensure that the content created by the user can be safely migrated to the next version, using the available 

tools, a set of actions and best practice workflows need to be done during the initial setup of the customer 

machine for Advance Steel: 

1. Setup the Author. 

2. Create a new Defaults profile. 

https://knowledge.autodesk.com/support/advance-steel/learn-explore/caas/CloudHelp/cloudhelp/2016/ENU/AdvSteel-FAQ-List/files/GUID-97946550-7C10-4A0D-997F-38E53D6DC4D2-htm.html
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On a new Advance Steel installation, the default profile for the general Advance Steel configurations done in 

the Management Tools > Defaults tab is set on “AdvanceSteel”:   

 

To ensure that the database merge action necessary for the migration process will correctly collect any user 

modifications made to the defaults, a new profile needs to be created: 

- Use New Profile, in the Management Tools > Defaults tab 

 
- Enter a preferred profile name 

- Select it from the drop-down list 

 
- Use Set selection as current profile 

 
 

3. If a new line is added to an existing steel profile section in AstorProfiles, change the owner entry to match the 

Author value: 

 

Chapter II – Library Content 
Reviewing existing content and adding missing profiles, bolts and materials 

An important step during any implementation is adding the custom content needed to meet customer 

requirements. 

While evaluating the customer workflow and projects, it has been noticed that some profile sections, bolts, 

anchors, gratings and so on, may not be available in Advance Steel. Therefore, the content needs to be added and 
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easily be made available to the customer, on all machines. Also, creating a back-up is advisable, to ensure that the 

custom content can be re-added if needed. 

Steel Profiles 

Advance Steel provides a wide variety of steel sections, covering standard libraries for most markets, but new 

libraries or custom profiles and sizes (used only for a specific project or by a manufacturer) may need to be added 

in Advance Steel. 

All Advance Steel profiles are stored in databases, and most of the steel profile implementation actions require a 

fully dedicated .mdb database editor tool or an installed version of Advance Steel. 

Before starting to add the missing sections or profiles necessary for the customer, the section coming from the 

catalog or specification should identify what method to apply when being added, in order to choose the simplest 

and most efficient one. 

It’s preferable that the new sections be added using the predefined shapes, recognized by Advance Steel through 

their parameters; For example, “I” beams, which are not added as an I-beam contour, but through a series of 

parameters like web height, flange thickness or web-flange fillet radius, that are then used by Advance Steel to 

build a parametric section which will take full advantage of steel connections and automatic detailing.  

Is the section that needs to be added already available in Advance Steel? 

Most Advance Steel profiles, available with the out-of-the-box version of the software, use standard profile 

shapes, that are parametrically built by Advance Steel, using a set of values that come from manufacture 

specifications; For example, flange width, web thickness, inner diameter and so on.  Those predefined shapes are 

preferred instead of User Sections because their shape is fully recognized by all Advance Steel modeling 

functionalities, such as connections, bolt positioning or automatic dimensioning for detailing.  

All the predefined shapes that should be used when adding a new profile can be found here: 

To add or modify those sections, you need to edit the Advance Steel profile database, using a dedicated database 

editor tool, such as Microsoft Access. 

The profile database can be found in the following default path: C:\ProgramData\Autodesk\Advance\Data 

Adding new sizes to existing profiles is a simple operation that requires adding new information to the 

existing database structure, with the new parameters that define the section shape and its naming. 

Example: Adding a new HSS Pipe to the existing section class available in Advance Steel, with new geometrical 

characteristics. 

Step 1: Identify the table that defines the section, by using the profile name from Advance Steel 

 Create a profile in Advance Steel, using the section to which you need to add a new size. 

 Click inside the section definition field, and copy the profile name. 



                                                                                                  Advance Steel Implementation Guide                                                                                                                   
 

22 
 

 

 In the profile definition database, search and open the table named ProfileMasterTable. 

 

 Scroll right to the column called USEnglish. This column contains the profile names for all the Advance 

Steel sections, used in the US language and content installation. 

 Search the section name copied above in the USEnglish column. 

Step 2: Add the new section size to the existing profile definition table 

Once you find the profile definition line, scroll right and copy the value from the TableName column associated to 

this definition line: 
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 Open the table from the same database with this name (EXT_AISC14_HSS_Round). This is the table that 

contains the actual definition for the Advance Steel profile, with the geometric parameters that are used 

to create the section in the 3D model.  

 

 
 

 Add a new line with the new section size. Match the required parameters with the ones coming from the 

specifications. Make sure the naming is correctly done, with the SectionName column value being used 

within Advance Steel.  

 

How are new sections added to the Advance Steel database? 

To add a new section in Advance Steel you can: 

 Use a Standard Shape defined in Advance Steel 

Or 

 Create a User Section 

Standard shapes available in Advance Steel 

The best way to add a new section is to use an existing shape available in Advance Steel and add the new section 

directly in the Database. This is recommended because standard shapes in Advance Steel come with a large variety 

of advantages, which User Sections do not have. For example, when Advance Steel creates a standard shape “I “ 

beam, set with the customer parameters, it can logically identify the beam web, the beam flange, the thickness of 

each side and so on, and use those inside connections or for detailing rules. A user section, even if defined to look 

like an “I” beam, will not have this information – because user sections can have any shape, even non-standard or 

random ones.  

To add a new section using the standard shapes, please review this article. 

Add new sections as User sections 

When the shape of the section is not available in Advance Steel, which appears in most cases when defining 

claddings, the new customer profiles are added using the User Section functionality.  

https://knowledge.autodesk.com/support/advance-steel/troubleshooting/caas/discussion/t5/Advance-Steel-General-Discussion/How-to-create-new-section-profile-/td-p/5213101.html
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Learn how to Create a user section in Advance Steel. 

Use the new sections during modeling 

Any newly added section can be used instantly, after adding it in the database, by searching the Advance Steel 

Beam object properties dialog. 

To further utilize those sections, you need to add them to: 

 Preferred sizes 

 Existing macros 

Add sections to Existing macros 

Often, new sections need to be added to existing Macros. For example, new purlin sections should be added to the 

Purlin structural command, railing tubes to the Railing macro and so on. 

You can do this by adding new definition lines in tables associated to each of those configurations. For more 

information, review this article. 

Bolts and Anchors 

Adding new Bolts and Anchors in Advance Steel is realized mainly through the Management Tools dedicated 

editors, with no database edit requirements.  

Editing bolts, anchors and shear studs 

Using the dedicated editors in Management Tools, the following parameters can be edited for any existing 

bolt/anchor/shear stud available in the out-of-the-box installation of Advance Steel: 

 New diameters 

 New steel grades 

 Modify the Source 

 New or modified rod lengths, including the grip formulas 

 New assembly sets 

 Modified existing assembly sets 

 Different naming for existing bolt name parts 

 Hole tolerance 

Important! To save the progress of an edited bolt, at any point, all the parameters need to have at least one value.  

Using the Management Tools editor 

 Open the Management Tools, select the editor for the connector that needs to be edited and select it 

from the list on the left. 

New Steel Grade 

 With the Grade checkbox unchecked, select the new steel grade from the drop-down list. 

https://knowledge.autodesk.com/support/advance-steel/learn-explore/caas/CloudHelp/cloudhelp/2015/ENU/AdvSteel-FAQ-List/files/GUID-375BDDC1-7AAE-44A8-8820-29CD55BC0BA1-htm.html
https://knowledge.autodesk.com/support/advance-steel/troubleshooting/caas/discussion/t5/Advance-Steel-General-Discussion/New-type-Truss-for-macro/td-p/5328501.html
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Once a new steel grade is selected, the rest of the bolt configurations will disappear. 

If the required steel grade does not exist in the drop-down menu, use the New… button to create it. 

The image below highlights how after selecting a new grade for the A490 bolt, all the settings, associated 

to this bolt disappear. At this point the bolt is not functional. 

 

 Use the Copy from… button associated to the Grade parameter. Chose the same bolt values, and select 

the material grade that had a bolt configuration assigned to it. In this case, it is the 10.9 steel grade. 

Diameter and name of bolt assembly parameters remain greyed out as they are not relevant here. 

 

 
 

 After the copy is done, use the Apply to save the settings. 

 By default, the Management Tools will revert the page appearance back to the old steel grade. To see the 

new steel grade added to this bolt, including the copy of all the geometrical parameters done above, use 

the checkbox next to the Grade parameter and expand the drop-down list – it will now show two steel 

grades: 10.9, and the new 8.8 one. 
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New diameter 

New diameters are created is done in a similar way to new steel grades.  

The new diameter can be either selected from the available diameters in Advance Steel, by unchecking the 

checkbox next to Diameter and searching through the drop down menu, or by using the New… button. 

You can also use the Copy from… command, but in this case, it will also require an existing diameter from which 

the copy needs to be done. As a new diameter will most likely require other geometrical modifications to the bolt 

(different grip lengths, rod lengths, head size etc.), this step is not mandatory, but it can represent a good start. 

Modify Source 

The Source attribute of a bolt/anchor/shear stud is a global value, therefore, you can simply modify it with no need 

any other actions. 

 

New or modified bolt/anchor rods 

An Advance Steel bolt, in addition to the set attributes, is defined through a table where different lengths can be 

added. 

The table is unique per Diameter and Steel grade, so different lengths can be configured for identical bolt diameter 

that have different steel grades. 
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Edit the bolt lengths table: 

 Set the bolt steel grade and diameter for the bolt that needs modifications. 

 Go to the Bolts tab. 

 

o The A, B and Number of corners define the bolt head geometric values.  

For the Number of corners, setting the value 0 (zero) generates a round bolt head, while values 1, 

2 and 3 do not work.  

o The table in the center of the dialog contains the actual bolt lengths. 

You can edit definition lines or add new lines by typing inside the bottom row. 
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Values accepted in the table: 

 Length – bolt rod length. The table will sort the length values from low to high, after you 

click Apply. The table does not support duplicate length value entries. 

 Weight – the bolt rod weight used to calculate the total bolt weight, but summing it up 

with the washer and nuts weights. 

 Part name – the bolt part name, displayed only in exploded bolt lists. The whole bolt 

assembly name is defined differently.  

 

New or modified bolt/anchor assembly sets 

The Set tab available in the Bolt/Anchor editor controls the number of washers and nuts and their position in 

relation to the bolt head and the grip. 

To modify an existing bolt assembly, available for the respective bolt, set the bolt diameter and steel grade, and go 

to the Set tab. Check the checkbox next to the Name of bolt assembly parameter, and use the drop-down menu to 

select one of the already configured sets for this bolt. 

 

You can add a new set by setting the bolt diameter and steel grade, and then going to the Set tab to: 

 Use New… to add a new set name. 

 Select one of the available sets in the database from the drop down menu. 

Note: Make sure the checkbox is not checked.  
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Note: The name of the set is not relevant for how the shape is defined. Any combination of nuts and washers can be 

included under a set with any name. The name will appear in the bolt properties during modeling.  

Adding/modifying/removing washers and nuts from the bolt assembly 

Once the set is defined, use the two pages below to define the number of nuts and washers, as well as their 

relative position to the bolt head. 

 

The top group defines the nuts and washers between the bolt grip and the bolt head, while the bottom group 

defines the nuts and washers between the grip and the bolt end.  

 The “+” button adds a new washer or nut to the respective group. 

The Set selection dialog appears. In this dialog you need to set the: 

 

o Set – Nut or Washer 

o Type – Nut or washer type name 

o Grade – Nut or washer steel grade. It can be set differently from the bolt grade if needed. 

o Diameter – Nut or washer diameter. It should be set equal to the bolt diameter to which it will 

belong. 

 

 
 

 The “-“button deletes the selected nut or washer from the list. 

 The “Up” and “Down” buttons move the selected nut/washer up or down in its category. The position in 

the list sets its position in relation to the bolt head. 
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For the top group: the top nuts/washers are the ones next to the bolt head, the bottom ones are the ones 

next to the grip objects. 

For the bottom group: the top nuts/washers are the ones next to the grip objects.  

Hole tolerance 

The Holes tab offers settings for the hole the bolt will create in the model. 

By default, with no settings made here, Advance Steel will create holes and set the hole tolerance equal to default 

values found in the Defaults tab in  Management Tools. 

 

The settings made in the Holes tab will override those values. 

 

 Location: location of the hole that is overridden by the settings below: 

o All: All holes. 

o First: Hole that belongs to the first object after the bolt head, in the bolt grip. 

o Last: Hole that belongs to the last object in the bolt grip. 

 Type : Hole type 

 Tolerance 

  

Defining the grip length rules 

The method the bolt uses to assign a fix bolt length (based on the thickness of the bolt grip on the connected 

objects) is set using a number of rules that are then used to generate a table with the bolt lengths assigned to the 

various grip intervals.  

Check the To calculate length automatic (For this type) checkbox to activate the automatic length calculation based 

on those rules. 
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For more information about how the grip length rules are defined, review this article. 

Gratings 

Advance Steel gratings can be created and defined using two different commands: 

 Standard Gratings: These objects use a predefined geometrical size for width and length, which is 

defined from the database according to the provider specifications. 

 

 Variable Grating: The geometrical size, in this case, is variable, while the grating can reuse the same 

naming and characteristics as the standard gratings. 

Because a variable grating can have any shape (including a polygonal one), this object should be used 

only when the grating does not need to be split in individual standard plates for ordering, as the 

object in the model does not have an option to split and optimize.  

Even if the two gratings share the same grating types, they are defined separately in the database and completely 

independently.  

Adding a new grating should be done based on the manufacture requirements: 

 Is the grating added only due to naming reasons? If so, then the grating should be added in both the 

Standard and Variable tables, so it can be used in either place according to the needs.  

 Does the new grating come from a manufacture specification that contains length/width 

requirements? If so, the grating is added in the Standard category, and (if needed) in the Variable 

category, by using the exact naming except the length/width sizes. 

E.g.: Checker plate grating exists as: 

o Standard grating: Checker Plate ½ (24x24) ; Checker Plate ½ (12x24) 

o Variable grating: Checker Plate ½   

Learn how to Add a Grating in Advance Steel. 

https://knowledge.autodesk.com/support/advance-steel/learn-explore/caas/CloudHelp/cloudhelp/2016/ENU/AdvSteel-FAQ-List/files/GUID-350B6808-C82D-422E-9548-2F0FC5419A23-htm.html
https://knowledge.autodesk.com/support/advance-steel/troubleshooting/caas/sfdcarticles/sfdcarticles/Advance-Steel-How-to-add-custom-steel-grates.html
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Material, Finishes and Other Attributes 

A wide variety of object properties are set in Advance Steel, using the object properties dialog. 

The Material is an object property that does not have a graphical influence in the model (e.g. Coloring the object in 

the material color), but it is an important attribute when calculating the object weight, and a property that will be 

associated to the object in all output documents: Drawings, NC, Bill of Materials, etc. 

Finishes (Coating) is also an object property used for the fabrication drawings output and is strictly informative. It 

does not have any option to influence the object weight or other specific geometric parameters. An object can 

only have one associated coating attribute at a time.  

Adding or modifying the object attributes is done, using the Management Tools – Object Property Editor.  

 

The Object Property Editor consists of a set of attributes that can be edited and the location where new attributes 

can be added. 

In the databases, the properties are stored as follows: 

 All properties that come with the Advance Steel installation are stored in the AstorBase.mdb 

database, in various tables (E.g. Materials are stored in the table named Material). 

 

 All properties that are added using the New command are stored in the AstorAddIn database, in 

similar tables to the one used by the out-of-the-box settings. Those tables are installed empty, so 

they will only contain the new user settings. As those settings are stored in the AstorAddIn database, 

when migrating to a new version they will automatically be migrated when copying the database 

from the older version to the new one. 

 

 

Best practice advice: To ensure a migration through the AstorAddIn database copy, modifications to the object 

properties should be done, using the New command, and simply adding new properties. When an existing property 

is modified, those settings are stored in the AstroBase database, in tables that are NOT converted to the newer 

version through the Covert Database tool.  



                                                                                                  Advance Steel Implementation Guide                                                                                                                   
 

33 
 

Chapter III – Generic Settings 

Preferred Sizes 

The Advance Steel Preferred sizes functionality allows you to apply a filter over the entire content library, in order 

to easily display only the data you frequently use. 

  

The small list under I Section beams, in the Advance Steel Beam properties dialog is an effect of the preferred sizes 

set in this particular configuration, where the four listed “I” beams represent the most used sections.  

This filtering does not restrict access to the rest of the content library, which can still be accessed from the same 

dialog. Under the four preferred sizes highlighted above, you can click on All and this will list every other I Section 

beam available at that point in the Advance Steel content library. 

Configure Preferred sizes 

All preferred sizes configurations are made using the Management Tools > Preferred sizes. 

 

Configuration is made first based on object class – Beam, Plate, Bolt etc. , with a separate set of attributes inside 

each class that allow you to assign different preferred sizes for the Material grade for Beams and Plates, for 

example. 

Configuring the Preferred sizes does not influence the default way Advance Steel uses certain materials and model 

roles during modeling. Those configurations are made from different areas. 



                                                                                                  Advance Steel Implementation Guide                                                                                                                   
 

34 
 

Configure preferred sizes using Management Tools 

On the left side of the Preferred Sizes tab in Management Tools, there is a list of all the different object types and 

attributes that support this customization. 

Clicking on any of them will display a split view on the right side, where: 

 The top side: all the available classes (Sections, Materials, Thicknesses, etc.) from the Advance Steel 

content library. 

 The bottom side: the content set as Preferred. 

Beam Preferred Sizes 

Configure Beam Section groups: 

 

Go to Management Tools > Preferred Sizes tab > Section groups. 

Move any of the groups available in the profile library (top side) to the Preferred Classes section on the bottom 

side, using the Add arrow. Use the Remove arrow the remove any of the existing groups. 
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Configure Beam Section class: 

 

Go to Management Tools > Preferred Sizes tab > Section class. 

Because each group configured above contains a set of different classes, this configuration is done per group, so 

each group will contain its own set of preferred classes. 

The Section class list on the left side tree view contains all the different section groups available in the Advance 

Steel profile library. To only see the groups that were already set as preferred, use the small checkbox on the right 

side of the title. 

 

Add or remove preferred classes as needed. 

 

 



                                                                                                  Advance Steel Implementation Guide                                                                                                                   
 

36 
 

Configure Beam Sections: 

 

Use the checkbox next to Sections, as before, to filter out only those section classes set as preferred, and then add 

or remove section sizes that are most commonly used. 

In addition to the section specific configuration of preferred sizes for Beam elements, the dialog also offers the 

option to choose the material and model role preferred sizes, in a similar way. Even if material or model role are 

generic attributes for many different objects, those settings are applied per object type, based on the 

configuration. 

Plate Preferred Sizes 

In addition to the Plate specific model role and material preferred sizes, you can configure the thickness, and have 

preferred thickness sizes available in the drop-down menu when modeling plates (besides the existing possibility 

to manually write the plate thickness for each individual element). 

 

The dialog offers a wide variety of plate thicknesses, for both metric and imperial units.  
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If you need to add more thickness values that are not already in the list, you need to manually add them in a 

database.  

To add new thickness values to a database: 

1. Open the Management Tools > Table editor. 

2. Click the Open ODBC button and type PlateThickness in the filter box. 

 

 A single table will be found: PlateThickness, inside the AstorBase database. Open it. 

 Add a new line with the required thickness. Fill-in the three columns as follows: 

o Key = a numeric value that represents the thickness, expressed in millimeter units. E.g. : a ¼ inch 

thickness has the KeyThicknessValue equal to 6.35. 

o RunName = the thickness name that will appear in Advance Steel. This can be anything, and can 

even contain text (such as “inch”).  

o OwnerText = the customer set Author. As editing is done manually, the default owner will not be 

used as default, but manually selected from the drop-down menu.  

Bolt, Anchor and Shear Stud Preferred Sizes 

For bolts, anchors and shear studs, you can set preferred sizes for:  

 Diameter 

 Material 

 Standard 

 Set (only for bolts and anchors) 

Unlike preferred sizes for beams, these sizes are not per each different bolt, anchor orshear stud found in the 

content library. Instead, the set values are generic and applied only if the bolt/anchor/shear stud is used. 

For example: both 1/2” and 1” diameters are configured as preferred sizes. The modeled bolt doesn’t have a ½” 

diameter, but it has a 1” diameter -> Advance Steel will display only the 1” diameter in the preferred sizes list, and 

ignore the other configuration. 
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Gratings Preferred Sizes 

Similarly to beams, gratings preferred sizes can be set for: 

 Material 

 Model Role 

 Class and size 

The class and size configuration offers two groups: Standard Gratings and Variable Gratings. 

Since standard and variable gratings are two different objects in Advance Steel, the settings for preferred sizes are 

independent from one another, and both need to be done in order to cover any objects used in the 3D model.  

Scale Preferred Sizes 

Detailing scales can also be controlled using the preferred sizes dialog. Similarly to the plate thickness, the dialog 

offers the option to add both metric and imperial scales, and Advance Steel will display them based on the Project 

Specifics – for example, an imperial unit based project will list only the imperial scales as preferred. 

The settings done here influence the scale setting on the drawing generation dialog. 

 

Save, Use and Transfer Preferred Sizes Profiles  

Once the preferred sizes are configured, use the Apply command to save the modifications in the current 

database: 
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All the preferred size profiles are stored in the AstorAddIn.mdb database (…\ \Autodesk\Advance Steel 

2017\User2\Data\). 

The database is copied from one version to another, so when migrating the user configurations from an older 

Advance Steel version to a newer one, the preferred sizes will be transferred as default as part of the user specific 

database.  

Profiles: Multiple profiles can be created and configured separately.  They can be then used in the project, by 

switching between profiles using the Project data > Preferences tab: 

 

This option is useful when the project specifics of the company require a different set of content libraries (e.g. 

Projects done for different Geos with different standards). 

You can easily create profiles using the New button on the top-left corner of the Management Tools window. Complementary 

commands for profile management (such as Delete o Duplicate) are also available: 

 
 

Switching between profiles is very easy, and is done per project using the Project settings dialo:.  
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Profiles for Generic Settings in Management Tools 

A wide set of configurations that affect all the Advance Steel functionalities, from 3D modeling to fabrication 

output are stored using Default values, set in the Management Tools >  Defaults tab. 

 

In some cases the project specifics or country standards may require the change of certain default values to adapt 

the output or the workflow to the requirements. Therefore, it is advised to use default value profiles, that allow: 

 Different setups stored in multiple profiles for an easy switch between projects. 

 Import/Export profile functionalities, to easily transfer a set of default values to a different computer.  

Manage Multiple Default Profiles 

Use the New or Copy profile commands to create a new profile: 

 New will create a new profile by using the default out-of-the box Advance Steel values. 

 Copy will create a new profile by starting with the values configured in the current default profile 

 

Select the profile from the combo-box, and set it as the current profile to allow the Management Tools to edit it, 

and Advance Steel to use it. 

 

The active profile is highlighted in Management Tools by the presence of its name on the top-left corner of the tab. 
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Important! If Advance Steel is running when you change a default value or when you activate a different profile, 

use the Load settings in Advance command to load the values in the running Advance Steel session: 

  

 

Chapter IV – Modeling Requirements 
 

The 3D Model Template (.dwt) 

When starting a new project in Advance Steel, the 3D model will use a template file, specific to the AutoCAD 

environment, which contains a set of important Advance Steel setting that set project specifics like Units and 

Layers. 

The generic name for the Advance Steel template, that is installed and used by default for the out-of-the-box 

version, is ASTemplate.dwt, DWT being the standard AutoCAD template file format. 

Those files are found by default in the relative folder \Shared\Support\Templates\...  

“C:\ProgramData\Autodesk\Advance Steel 2017\Shared\Support\Templates\” 

Edit Advance Steel Templates 

The template stores two very important settings: 

 Project unit settings 

 Layer settings - used to control the color of an object in the model used automatically when Advance 

Steel creates new elements. 
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In addition to this, the template contains other AutoCAD-specific settings, used for the 3D modeling environment, 

such as: 

 Visual style settings 

 Text style settings 

 Dimension style settings 

You can edit them using the AutoCAD functionalities. 

Start editing a template 

When you edit a template, it is very important you edit it in a pure AutoCAD environment, without loading 

Advance Steel: 

1. Open AutoCAD using the desktop shortcut 

2. Use Open file 

3. Change the File of type setting to Drawing Template(*.dwt) 

 

 
 

4. Browse to c:\ProgramData\Autodesk\Advance Steel 2017\Shared\Support\Templates\ and open 

ASTemplate.dwt 

 

Edit the template specific settings 

Layer editing 

The presence of layers in the template is important for the Advance Steel automatic object to layer assignment 

mechanism. The layers, together with a set of defaults found in Management Tools allow Advance Steel to assign 

objects to specific layers while modeling. This automatically ensures that specific objects (beams, plates, etc.) are 

created on dedicated layers, and also control their color in the model. 

You add / edit layers is using the AutoCAD commands.  

1. Open the Layer Properties dialog using the “_layer” command, or from the ribbon: Home tab > Layers 

panel: 
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2. Add/rename layers as required. 

If the layer names were changed, the mapping of those layers to the Advance Steel mechanism of automatically 

assigning the objects during modeling needs to be updated as follows: 

 Open the Management Tools >  Defaults 

 Expand the Layer assignment > General  category  

 Edit the defaults found on this page and match the name of the layer with the name of the default 

 
Important! For the Advance Steel mechanism to work as intended, the layer that is set as default in the template 

needs to be a layer called “Standard”. 

 

The “Standard” layer set as default is a requirement at any step of the modeling phase. If changed, even in the 

model, Advance Steel will stop using the automatic rules and create all the objects on the same layer – the layer set 

as Active at that point.  

Unit settings 

The Advance Steel template also stores the unit settings that will be set as default when starting a new project. 

Those units can be changed from the Project data, but having them preset in the template helps getting a new 

project stared faster. 

To set up the units: 

 Open the AutoCAD Units option using the _units command. 

 Set the Insertion scale units to the desired unit. 



                                                                                                  Advance Steel Implementation Guide                                                                                                                   
 

44 
 

 Set how the length unit is represented from Length – Type and Precision. 

Note: the Angle units do not affect any of the Advance Steel functionalities. 

 

 Close the dialog and use Save as from the AutoCAD menu. 

 Change File of type setting to Drawing Template(*.dwt). 

 

 Choose a name if needed and save. 

 In the next dialog that appears, set the Measurement to one of the two values, based on the template 

specifics: 

o English – imperial based template, with units set to inch, pounds, etc. 

o Metric – metric based templates, with units set to mm, kg, etc. 
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 The Description field can be used for notes that describe the template, but will have no effect in the 

Advance Steel model. 

 Press OK to save the file. 

You cannot change other units, such as length, from the template level. Based on the template characteristics 

(Metric or Imperial), the weight, area, volume and so on, will be set accordingly, based on an internal mapping.  

For example, for an Imperial template, the weight is set to pound, the area to square foot and the volume to cubic 

inch. 

Steel Connections – Predefined Configurations  

An easy way to deploy steel connections in the model stage is to use the Advance Steel Joint Library functionality. 

This library is a collection of parameters that are instantly applied to a connection, allowing the connection detailer 

to quickly configure the connection’s geometrical parameters based on the input parameters. 

During the implementation stage, an important step is to review and make the necessary configurations to the 

existing libraries. Those connection libraries can be shared between multiple users, and also migrated from one 

version to another – they are an important component that simplify the modeling stage and reduce any potential 

connection design errors. 

Use and review library entries 

Each steel connection in Advance Steel contains a Library tab, which is specific per connection – use a different 

location in the program database system. 

 

This tab contains a table-style view, with multiple entries that have an associated set of values. 

You can switch between those entries by clicking on the lines and this will apply the respective set of values to the 

connection configuration. All the geometrical or attribute settings available in the connection are stored here, so 

the configuration can be fully stored, without losing any parameters. 

When adjusting those entries: 
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 Review the existing entries: 

For most used steel connections, Advance Steel provides out-of-the-box configurations for the most 

common beam configurations.  

For example, the Clip Angle connection provides a full set of pre-configurations, valid for the connection 

created between a column and any W-Shape rafter. The Comment column in those configurations also 

provides additional information – like the number of bolts configured in the connection. 

You can review entries by creating the connection and switching them – Advance Steel will automatically 

update the connection to use the preset.  

 Modify the existing configuration: 

 

o Use the existing entry to apply all the parameters to the current connection. 

o Modify the connection as needed (e.g. – Increase the distance between the bolts, add an 

extra bolt line, modify the weld parameters and so on) 

o Use the Save values button. A new line with those parameters will be created at the bottom 

of the list, with no comment (“-“). 

 

o Use the Edit button to enable the edit mode for the table view. 

o Add comments to the line to easily identify it. The existing line used as a template can be 

removed if it doesn’t match the company standard, to avoid overlaps. 

 

Add new steel connection presets to the Library 

For connections that don’t offer any out-of-the-box presets, or the preset is made on a totally new scenario, you 

can also add lines to the Library using the Save values. A clear Comment is advisable for providing enough 

information during the modeling stage for detailers. 
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Automatically apply the library saves and use wildcards in input section configuration 

To simplify the use of library settings, an important step of the connection library deployment is to properly set the 

input elements in the library entry. 

The two highlighted columns contain information about what element is selected while inserting the Clip angle 

connection in an Advance Steel model.  

 

When the selected elements in the model match the section values stored in a library entry, Advance Steel will 

automatically apply it to the connection, configuring the connection geometrically to match the requirements for 

that scenario. This improves productivity when applying steel connections, reducing the chances of an incorrect 

value in one of the connections.  

Based on the following configuration possibilities, the Library can be used in various scenarios, answering to most 

common workflow requirements: 

 Use an exact profile name in the Section fields. By default, this is how Advance Steel saves a library entry, 

so creating the connection between beams modeled as required by the project and saving the respective 

entry in the database will ensure a fast and smooth configuration. 

 Use a dash “-“, combined with the default name entered in the Comment field.  

To do this, access the Edit dialog in the Library. 

Those two parameters allow the configuration of a default line, which will always be used by Advance 

Steel, regardless of the connection input elements or their positioning in the model. 

 Use only one dash for the sections, while configuring them with a relevant name. This allows the 

configuration of multiple lines, and prevents Advance Steel from using them automatically.  

You will then be able to select the lines and apply the values manually, depending on the scenario. 

 Use wildcard values: 

A common practice when creating good library entries that are automatically used, but covering multiple 

scenarios, is to use wildcard values. Those are introduced in the Section name definition of the library, and 

can partially or fully replace a section name. 

Example: 

AISC 14.1W\% - tells the library entry that this line will apply for all AISC 14.1 W sections, regardless of the 

section size. 
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AISC 14.1 W\W21% - adds additional filtering to the rule above. It still applies to all AISC 14.1 W sections, 

but it also filters those that are W21. This means that this rule will apply the connection to W21x68, 

W21x62, W21x101, etc.  

 

 

Chapter V – Numbering 

Setting up Advance Steel to provide element numbering for both assembly and parts requires a mix of 

configuration and workflow adjustments, to allow automatic rules to create the part marks following a set of 

parameters during the automatic identical part detection and numbering process. 

Prefixes 

There are two manual prefix methods that can be used on demand if some specific objects require a distinct prefix 

that can’t be covered by a generic rule. In addition to these, Advance Steel provides a configuration page where 

prefixes for all objects can be set, and then automatically used during the numbering process. 

The prefix configuration also requires a workflow adjustment during 3D modeling in Advance Steel, where certain 

model role attributes need to be set for steel beams and plates. 

You can adjust the prefix configuration using the Prefix settings, located in the Output tab > Part marks panel: 

  

In addition to the Advance category that stores out-of-the-box prefix settings, any customer setting needs to be 

stored in one of the two other existing categories: User or Project. 

User: settings are stored in Advance Steel files, and can be reused at any point by the same user on multiple 

projects. Also, as the settings are stored in a database, they are available to anyone within the company that 

connects to the same configuration files. 

Project: the configuration is stored within the model file itself. Any change done to the project category will not 

affect the Advance Steel configuration files. Therefore, this is not shared with other projects or other users. 

Instead, the entire prefix configuration will be available when opening the respective model file on any computer 

(inside or outside the company). 

The prefix settings categories can be used as follows, to ensure the best possible output and also to easily 

exchange these settings from project to project, when prefix requirements need to be adjusted: 
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 Use the same prefix rules for all projects. To do this, it is best to use the default User category that 

contains all the prefix configurations in the out-of-the-box Advance one. All modifications can be made in 

the user category set as the current profile.  

 When you need different prefix settings based on various projects, you can set multiple prefix profiles 

inside the User category. You can then easily switch between them by right clicking and choosing Set as 

current profile. The profiles can have any names. 

 For prefix rules that are unique to a specific project, you can use the Project category.  

This category cannot be set as preferred, and it will always be used when numbering is applied to the 

respective model, and all the prefix settings within it are used with priority. The current profile is used 

only for prefix configurations that are missing from the Project settings.  

Set up a prefix configuration profile 

1. Identify the complexity of the prefix rules from the customer requirements. Scan through the documents 

and group the different object types and extract the prefixes from the part marks. 

The most common example is where based on structural or construction role the objects get a different 

part mark: 

Single parts:  

 Clip angles - a 

 Shear plates – p 

 Base plate – BP 

Assemblies: 

 Column – C 

 Rafter beam – B 

 

Because the prefix is different between identical objects – steel beams and plates, an additional level of 

filtering is needed within the objects to allow Advance Steel to differentiate between a column steel 

beam and an angle steel beam (used as Clip angles). Use the the Model Role, an object property that 

defines the role of each object in the model, regardless of its geometric characteristics. 
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2. Create a prefix configuration rule. 

Once the prefix rules are set, start making the configuration in Advance Steel. 

Open Prefix configuration dialog. 

 

 If the customer has only one generic rule for prefixes, used in all project, use the existing Default 

category, under User. 

 For customers that have different prefix rules, that can change based on default, the Prefix 

configuration dialog offers the option to create multiple profiles.  

Only one profile can be active at a time. 
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Create new profiles: 

 

 
 

Activate a profile: 

 

 
 

 

 

3. Edit the prefix configuration rule. 

The prefix rule is structured based on a set of criteria. 

 The first is the object type. The object type is the base type of the element, not influenced by any 

model roles or other object attributes 
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 The second is the Model role. 

As model roles are generic (the same model role can be assigned to both beams and plates), in 

the prefix rule a combination of the two is selected (object type + model role). 

 

 The third is the numbering type, associated to a model role + object type combination.  

This page is obtained by selecting the model role from the list. 

For each model role + object type rule, the prefix can be set independently for preliminary mark, 

single part and assembly part 
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Use a prefix configuration rule during numbering 

To use an existing prefix configuration rule: 

 Check the Use Prefix checkbox in the Prefix configuration dialog. 

 

 Set the necessary profile to Active. The active status of a profile is highlighted as bold. 

 

 

Configure a generic prefix rule, ignoring the Model role 

When generic prefixes are needed, without using the model role as filtering criteria, they can be set to the 

Any category under the object type. 
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The generic prefixes can be set independently to each object type, but ignoring model roles. 

 

 

 

Add a new model role to the list 

The out-of-the-box installation will provide a set of generic model roles in the list, for each 

object type. As new model roles can be added to the database, the Prefix Configuration dialog 

offers the option to add new prefix rules, as follows: 

 Right click on the object type category, and select New. 

 
 Configure the following dialog with the necessary information 
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o Object type 

o Model role – all model roles in Advance Steel will be available here 

o Profile subtype – the generic beam shape (allowing an additional level of 

filtering for the prefix rules) 

 

 

 

Numbering Methods 

Advance Steel numbering consists of a two stage process: 

 First an identical part detection is performed where : 

- elements are taken individually, compared geometrically and the grouped into identical parts buckets  

- Assemblies are compared and grouped if they are identical – component elements are identically from a 

geometry point of view, and then their position along the main element of the assembly is  the same 

 After the identical parts and assembly “buckets” are created, numbering methods are applied to assign the 

part marks based on a specific set of rules.  

Identical part detection 

The identical part detection is an automated process where Advance Steel checks from a pure geometric point of 

view each element, and groups them to result in groups of identical parts. When performing this checking, several 

factors are taken into account: 

- Object Type and generic parameters.  

o Objects are always compared against other objects of their type, which means that for example 

beams will never be compared with plates, even if we have a Flat section and a plate with similar 

geometric sizes 

o Certain generic sizes are compared first, like for example the Plate thickness, or beam section 

type. For example two identical from a geometric point of view steel beams but which have 

different names will not be found identical. 

- Tolerance. When the geometry is compared, Advance Steel uses a preset tolerance value to allow very 

small geometric differences to not interfere in the grouping. This tolerance works as a length based 

setting, but it is not used only to compare one of the object sizes, but it can represent a combination of 

geometric differences. 
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The tolerance is configured from the default value: “Tolerance used for numbering”, found in 

Management Tools / Default 

 
 

 

 

Best practice advice: The tolerance value should be kept on a reasonable small value. Having a very small tolerance 

will trigger Advance Steel to find apparently identical assemblies different (the tolerance can even be set to zero), 

while a large tolerance (e.g. 1”) will group different assemblies into the same part mark. 

 

- Value-triggered differences through the object attributes. 

Each Advance Steel element have next to its attributes (Model Role, Commodity Number, Lot/Phase, User 

Attributes and so on) a small checkbox (which by default comes unchecked), which will force that 

attribute to act as a differentiator for numbering, in case the two objects are found identically from a 

geometric point of view. This means that for example to identical column assemblies can get a different 

assembly part mark, and be numbered differently, if the Lot/Phase for example is different and the small 

checkbox is checked.  
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Set-up numbering and post-numbering methods 

Numbering main dialog offers four sections, which are used to setup the numbering methods. Some of the settings 

found on this dialog are stored in Default settings (Management Tools / Default), so they can be set for multiple 

users, shared through the AstorSettings/Default profiles and migrated to other versions. 

Once a numbering method is setup, and the “Apply” button is used, it gets saved inside the project DWG file, so 

throughout the existence of the file the numbering method can be reused each time, with the same setting, even if 

the file is sent to a different computer which doesn’t have the same settings as the initial computer. 

 

1 – Preliminary mark numbering method. This activates the preliminary mark numbering, and allows the set of the 

start mark and the increment. This numbering method is independent of any post-numbering method or of the 

Single Part / Assembly numbering, and can be performed alone at any point – especially in preliminary stages of 

the modelling, to allow the creation of raw material lists or general arrangement drawings  

2 – Single part numbering method. This controls the method used to assign automatic numbers to individual part 

groups. It allows the set of the start mark, increment, method and display layout.  

3 – Assembly numbering method. This controls the method used to assign automatic numbers to assemblies 

groups. It allows the set of the start mark, increment, method and display layout 
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4 – Post numbering method applied once the initial method is used to assign part and assembly marks, and it uses 

a set of predefined rules.  

Single part / Assembly numbering methods 

As the methods for single part and assemblies are identical in concept, they will be described in the same time. 

Also it is a best practice recommendation to not mix them in the setup, and use the same method for both Single 

Part / Assembly part mark. Mixing them is possible, but the results may not be as intended.  

Advance Steel provides four different numbering methods: 

 

Method 1: “SP: 1000,1001….;Mp:1,2,3 

This is a standard numbering method where the part marks are given incrementally, to groups, based on the start 

mark for each Single Part and Assembly mark categories, using the independent increment for each category. This 

method doesn’t add any relation between the elements and an external interference. 

Method 2: SP: 1000,1001…..;Mp:1000,1,2,3 

This method uses similar mechanisms as the one above, with single part and assembly groups being numbered 

independently, using the Start and Increment values, but it adds one particularity: standalone objects, that are in 

the same time a single part element and an assembly (not being connected to anything else) will get the same part 

mark for assembly as it was for single part. 

For example: a standalone beam gets the mark “1005” based on the default numbering, the assembly mark will be 

also 1005 (ignoring the general assembly start and increment values). As a general best practices, those standalone 

elements will only get one shop drawing: an assembly drawing, so they will have a “Single part” mark (single part 

mark referring to the single part numbering interval) 

Add zeros options 

With both Method 1 and Method 2, an extra option appears on the dialog called “Add zeros” 

 

When activated this will add zeros in front of the part mark to reach a minimum size number.  

For example: selecting the value 2 for this option will output part marks that have only one decimal as 01,02, 03 

and so on. Once the part mark reaches 09, it will continue with 10, 11 and so on , so this option will no longer be 

applied.  The option is also not applied if we for example set it on 4, and then set the start mark at 1000. The 

number already has 4 decimals, so the numbering will simply assign 1000,1001 , ignoring this option. 
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Method 3 : SP : 1/1….1/32…3/32;Mp:1/1… 

This method ignores the start and increment values, and assigns a simple numbering rule that starts with 1/1, goes 

with an increment of 1 to 1/32, and then switches to 2/1……2/32….3/1 and so on. 

Different prefixes assigned to the parts and assemblies will generate different multiple successions, so in a model 

with can have C1/1, B/1/, Ab1/1 and so on, where C, B and Ab are prefixes.  

Important: The unique part mark for single parts and assemblies is the whole mark generated by the numbering, 

not only the numeric part of it generated by the method 

Method 4: With Drawing Number 

A very often used method, this allows Advance Steel to number the elements based on their position on the 

drawing, creating a strong relation between the element part mark the drawing on which the object is detailed. 

This method works through the following workflow: 

- With the model not numbered yet, we perform the numbering using the “With drawing method”. The 

numbering will then perform the automatic identical part detection, grouping the identical parts and 

assemblies, and then assign a placeholder mark to those group of elements, generically called 

#internal1000, #internal1 and so on. 

- The placeholder number is a valid number, and Advance Steel can work with it very good, but its role will 

be highlighted in the next step 

- Create single part and assembly drawings. When a drawing is created, Advance Steel assigned 

automatically a drawing number, which is unique per project. The start drawing number can be controlled 

for example during process detailing, or individually per object if the detailing is performed manually, with 

Drawing Styles. 

- Before going to replace the #internal1000 placeholder part marks, Advance Steel also assigned a counter 

to the drawing number obtained from the detailing process. This counter is required to avoid duplicate 

“drawing numbers” if the detailing is performed with multi-sheet strategies. 

The counter can be a small letter, capital letter or number, and it represents the position of the drawing 

on the sheet, so 

o It’s always 1, A or a for single-sheet drawings 

o It can be 1, 2,3 and so on for multi-sheets 

 

 “Start with first counter” will reset the counter for each sheet. If left unchecked, then the counter will 

“Grow” with each sheet, leading to drawing numbers like: A100, B101, C102 and so on. 

- The drawing number automatically assigned to the sheet is then used to replace the #internal1000 

placeholder part mark. The process is done automatically during detailing, so once the drawings are 

created the part marks are updated to match the new drawing numbers.  

Changing the part marks through “Change drawing number” functionality: As a common practice during a 

project, it is required to change the part mark of certain assembly or part mark. Because using this method 
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creates a “link” between the element mark and the drawing number where it is detailed, controlling the part 

will need an update of the two parameters, so the action in this case is to change the “Drawing number”, 

which will trigger a change in the part mark.  

- Open “Document Manager”  

- Browse the drawing list and find the drawing where the object that needs a part mark change is detailed 

on 

- Right click and use “Rename drawing number” 

 

- Enter the new drawing number. This functionality will: 

o Not allow you to insert a drawing number that already exists in this project, providing the 

drawing number a unique per project status 

o Automatically change the part mark (single part or assembly) of the object(s) detailed on the 

drawing 

o Change the file name, and use the new drawing number value that is part of the filename.  

- Once the drawing number is changed, this file and possibly other files will enter an Update required 

status, to perform a change in label for the new part marks.  

Single part / Assembly post-numbering methods 

The post-numbering rules are applied after the initial numbering, changing certain part marks based on the rules 

to match the definition. They can be used to obtain the numbering as expected. 

The post-numbering method is set from the combo-box at the top of the Numbering dialog, and offers the 

following options:  
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None: no post-numbering method, and the numbering will only relay on the main methods to define the 

numbering 

Assembly Group:  this post-numbering method will change all the single part marks to match the assembly part 

marks, together with an “identifier” to generate a unique part mark. 

 

Example of how it works: 

A model has 3 different assemblies numbered: B100, B101 and B102. 

- Assembly B100 has the attached parts: p1000, p1001 

- Assembly B101 has the attached parts: p1000, p1002 

- Assembly B102 has the attached parts: p1002, p1005 

All those marks were a result of a standard numbering, without any post-numbering method. 

Applying the “Assembly Group” post-numbering method will result in the following: 

 The model will still have the three assemblies: B100, B101 and B102, unmodified 

 The two attached parts from B100  : p1000 and p1001 will change their single part marks to : pa-B100 and pb-

B100, where :  

o “p” is the prefix (p1000) 

o “a” and “b” are counter marks that trigger a difference between the two elements 

o “-B100” is the assembly mark from which those two plates belong. 

 Going to assembly B101, the two attached parts that it previously had: p1000 and p1002 will change to : pa-

100 and pa-B101. The reason is : 

o “p1000” that was also attached to this assembly will switch is mark to “pa-B100”, because this 

attached plate already got a part mark from the previous assembly. As the element is still identic to 

the attached part from assembly B100, it will keep its name. 

o “p1002” is a “new” part mark that didn’t belong to the other assembly, so it will get a single part 

mark that contains the B101 assembly mark : pa-B101 

 For assembly B102, the two attached parts: p1002 and p1005 will change to pa-B101 and pa-B105, using the 

same logic as above.  

The attached parts will take the assembly mark in an ascending number order, and once set – it gets reused for all 

the other assemblies. If the attached parts would be different as single part marks between assemblies, then this 

rule would allow a very good grouping of part marks, where just by checking the attached part mark would give 

direct information of which assembly it belongs to.  
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Sp NO (for main part) = Assembly No: This method will assign to the element that represents the main part in the 

assembly the same single part mark as the assembly mark. 

Example of how it works:  

A column assembly C100, has from numbering the single part mark: c1000 for the column beam, and p1000 for the 

base plate. Applying this post-numbering method will change the single part mark for the column beam to C100, 

leaving the base plate as p1000. 

This method is very useful if the numbering is done with “With Drawing Number” method, and the process is 

configured to not create single part drawings for the main element in the assembly. Due to this, the main element 

in the assembly (for example the column beam element) will not get a single part drawing to generate its single 

part mark, so it will remain as #internal.  

Sp No (for standalone part) = Assembly No : the method only applies to standalone elements (e.g. bolted purlins, 

claddings), and the method will simply set the same single part mark as the main part mark, regardless of the 

single part main numbering method. 

Chapter VI – Detailing Setup 

Setting up Detailing Output 

Prototypes 

Prototypes act as a template for any new drawing generated with Advance Steel. Their main role is to maintain the 

page format and the header. Prototypes can be reused as much time as required to output drawings from a 

project. 

Prototypes are DWG files stored in the content folder path of Advance Steel. Edits to the prototype must be made 

with Advance Steel. 

The default directory for current prototypes is: C:\ProgramData\Autodesk\Advance Steel 

Ember\Shared\Support\Prototypes 

1. Editing / Adding Prototypes 

Any new prototype DWG files added to the folder are available to Advance Steel. 

 

When a new prototype is required 

 

 For only several small modifications to existing prototypes (for example changing logs, or adding 

a new Bill of Materials list), it is recommended to start from an existing prototype and apply all 

the modifications. 

For a new prototype, it is recommended to start from an empty AutoCAD file. Advance Steel entities can 

then be copied in from other prototypes, if needed.  

Edit a prototype with the current version of Advance Steel. 
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Prototypes like drawings use the Layout, and not the model space – so any modification needs to be done 

only in the active Layout. 

 

Use the flexibility of the AutoCAD editing tools to build your prototype: 

 Move or copy created lines and blocks. 

 Add attributes. 

 Set up the page. 

 Add printing size and colors.  

 

Set up the Units that will be used in the Prototype 

 

Be sure units are setup as required. The units in Advance Steel control what type of drawing will be produced: 

either Imperial or Metric. 

1. Setup the AutoCAD units. Type _units, and set up the units as required. It is important to specify the 

Insertion scale to match the unit lengths on the sheet. This ensures that blocks are correctly scaled.  

 

2. On the Home tab, click Project Settings. 
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3. Set the units as required. 

 
 

Define the Paper Size 

 

To ensure correct printing for Advance Steel drawings, the paper size needs to be specified accordingly.  

1. Right-click the Layout tab and select Page Setup Manager. 
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2. Add or edit existing Page setups and set it as current, which will mark it with an asterisk.  

 

3. Click Modify to open the Page setup dialog.  

4. Setup the paper size and the area to plot.  

 

5. Set up the CTB used for plotting. The CTB allows the control of line youight through colors. Advance Steel 

controls the color used to detail each distinct object, but not the line youight. You can control this for 

printing through the CTB, which maps colors to line youights. 
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Define the Prototype Frame 

 

The frame around the paper space is defined through AutoCAD lines and objects within the prototype. It is defined 

through a specific block and contains lines and text to define the appearance of the frame. 

 

Edit the page frame. 

1. Select the existing frame and use the _Explode command. 

2. Edit with AutoCAD commands: Edit/Create Lines, Add Text and Polylines. 

Redefine the page frame. 

3. Use the _Block command 

4. Select HYPERSTEELPAGEFRAME from the Name drop down menu 
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5. Leave the Base point coordinates at 0,0,0 

6. Use Select objects and select all the objects that define the page frame 

7. Make sure the Block Unit settings matches the prototype units. For example, set the Block Unit Settings to 

inches if the prototype is set to Imperial. 

8. Press OK. When prompted that the block definition was changed, click Redefine. 

9. Press OK to close the Edit Attributes dialog.  

10. Save the Prototype. 

Edit the Prototype Page Header  

 

Edit the prototype page header to arrange the prototype based on company standards. This includes artwork, 

logos, and other text information. 

1. Select the page header on the prototype. 

2. Press X to explode the page header. 

Once exploded, the header will display lines and tags which can be manipulated through normal AutoCAD 

commands. 

3. Stretch the existing lines that form the table border to resize the header. 

4. Create new lines to define the table. 

5. Move or create new Text objects for text information. 

6. Move or create new Attribute definitions to configure the tokens that display information from the 

model. 

7. Add or edit block references to insert pictures or other documents with customer information. 
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Once the edit is complete, recreate the entire page header block using the specific definition that matches 

the Advance Steel requirements. 

8. Select all the objects that belong to the page header with an AutoCAD selection from the top-left corner 

to right-left corner. 

 
It is important that none of the adjacent elements are caught in the selection. This include BoM on 

drawing templates, revision table or prototype page frame.  

9. Use _Block command to recreate the block. 

10. Select HYPERSTEELPAGEHEADER name from the Name drop-down menu. 
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11. Leave the Base point coordinates at 0,0,0 

12. Make sure the Block Unit settings matches the prototype units. For example, set the Block Unit Settings to 

inches if the prototype is set to Imperial. 

13. Press OK. When prompted that the block definition was changed, click Redefine. 

14. Press OK to close the Edit Attributes dialog.  

15. Save the Prototype. 

An important aspect of the Page Header creation is its size. The area the header occupies on the page will not be 

considered when calculating the space available to place views, especially when the detailing process checks 

different scales to see which fits better.  

The size of the page header that reserves the arrangement area on the prototype is not necessarily defined only by 

the size of the block. This area is a rectangle that needs to fit all the lines, texts, and pictures that are located in the 

Page Header block. As a result, it may be bigger than it actually uses: 

Edit the BoM on Drawing List Position 

 

For BoM on drawing lists to automatically appear on generated drawings, their template reference must be placed 

on the prototype. Here you can set its position, size, and direction in which it can grow when lines are added to it, 

and also its content. 

1. Click Insert a drawing list on the Labels & Dimensions tab. 
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2. Select a position on the prototype for the BoM with a rectangle. The corners of the rectangle (not all) 

should be selected based on the desired position of the list. 

 

3. Use the four checkboxes on the Layout tab of the dialog that appears once the BoM on drawing template 

is inserted to fix the list position in one of the corners of the rectangle. 

The BOM on drawing size is controlled through those corners. Even if all 4 corners can be locked, it is not 

desired as this will force the list to be scaled to fit in the respective rectangle.  

The workflow here is based on the customer requirement of how the list should be added in the prototype. For 

example: 
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From the Template tab, select a BoM template that is required for the respective Prototype. The template will be 

inserted in a “Before-update” state, and it will be automatically updated with the drawing information when 

creating the drawings from the model using this prototype. 

Add and Adjust a Revision Table 

 

Shop drawings usually have a revision table requirement. You add revision tables to a prototype which you can 

adjust once the drawing is created and updated with revision details. 

 

1. Click Revision table on the Labels & Dimensions tab. 

 

2. Select a rectangle in which the Revision table is to be inserted. 

3. Set up the Layout to control its size and its initial appearance. 

The first two options create the revision table only as a Header in the first stage. Multiple lines are added 

to it once revisions are created on drawings. The remaining two options create a revision table with 

empty lines.  
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4. Using the other tabs, format text styles, color, and column types. 

Change the Revision Table Header Names 

 

A common practice for Revision table configuration is to change their header names. 

For more information about renaming revision table header names, review the following article. 

Add Reserved Areas on the Prototype 

 

You often need to add certain objects to the prototype to accommodate customer requirements. This includes 

objects such as various tables with weld sizes, stamp reservation blocks, and bill of material drawing lists.  

While you detail, Advance Steel calculates the space available to fit the drawings based by subtracting the space 

occupied by the page header from the total paper space. To reserve more space, you can add a block named 

AS_RESERVED_AREA to the prototype, defined by a rectangle. 

1. Create a rectangle using the AutoCAD command _Rectangle in the area that needs to be reserved. 

2. Start the _Block command. 

3. Type the name AS_RESERVED_AREA in the name block. 

4. Leave the Base point coordinates at 0,0,0. 

5. Select the rectangle. 

6. Make sure the Block Unit settings matches the prototype units. For example, set the Block Unit Settings to 

inches if the prototype is set to Imperial. 

7. Press OK. When prompted that the block definition was changed, click Redefine. 

8. Press OK to close the Edit Attributes dialog.  

9. Save the prototype.  

https://knowledge.autodesk.com/support/advance-steel/troubleshooting/caas/sfdcarticles/sfdcarticles/Advance-Steel-Changing-titles-of-revision-table-columns.html
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Define the Detail Arrangement Settings 

 

While editing the prototype header you can specify detail layout properties which correctly position the details. 

Click Define drawing layout on the Output tab. 

 

The dialog offers layout options applicable for any type of drawing. 

 

Arrange detail in the center of the page frame (not applicable to multi drawings). On one per sheet drawings, the 

drawing needs to be centered. In addition, when this option is active, the Detail button on the right becomes 

available allowing you to define the center of the prototype. The center can be different then the theoretical 

center of the paper space. 

For Assembly drawings, the main view is centered. When creating a prototype for one per sheet assembly 

drawings, the center of the prototype is reference for the main view arrangement. This is usually the Front View.   

Detail arrangement. For multi-sheet drawings, Advance Steel will start from a corner of the prototype and arrange 

the views in columns or lines. The way this arrangement is done is controlled from one of the four options. 

 In columns from left to right. Advance Steel starts with the first view arranged at the top-left corner, 

placing the views downwards in a column, and switching to the next column from the top once the 

bottom side of the page is reached. 



                                                                                                  Advance Steel Implementation Guide                                                                                                                   
 

75 
 

 In columns from right to left. Advance Steel starts with the first view arranged at the top-right corner, 

placing the views downwards in a column, and switching to the next column from the top once the 

bottom side of the page is reached. 

 In lines from bottom to top. Advance Steel starts with the first view arranged at the bottom-left corner, 

arranging the views towards the right in a line, and switching to the next line above it once the right side 

of the page is reached. 

 In lines from top to bottom. Advance Steel starts with the first view arranged at the top-left corner, 

arranging the views towards the right in a line, and switching to the next line below it once the right side 

of the page is reached. 

 Start position.  

 

 

Color of the Detailed Objects 

When you create drawings, the color for objects is based on a set of user controlled defaults, instead of layers as is 

done in modeling. The layers in the prototypes are not relevant to the configuration, placing different objects with 

no influence to how the objects are drawn, such as color, line-type, and visibility. 

Single Part and Assembly Drawing Colors 

For all single part and assembly drawings, the color of the objects is based on line type. The same color is used for 

the visible lines of any object, without differentiating beams, plates or bolts. These colors are specified in the 

Management Tools, under the Drawing-Presentation/Colors category.  

Specify colors before or after the drawing is created. Updating the drawings will always use the current setting of 

the color defaults. 
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General Arrangement Drawings 

You can specify colors for detailed objects for General Arrangement Drawings in two ways. In Management Tools, 

under the Drawing-General category there is an option Use model layers for detail objects in Overview details. 

 

When deselected, the same rules when assigning the object color based on line type, as for Single Part/Assembly 

drawings will be used. 

When selected, the same colors for the objects as in the model will be used for visible lines. Based on line color, 

you can differentiate between object types (such as Columns, Rafters and Plates), if they are placed on different 

color layer in a 3D Model.  

Additionally, you can override those colors and force a color to be used for a specific object/line type. This is 

achieved with the automatic detailing mechanism (Drawing Style). 

Configure and Use Customized Dimension Styles 

Advance Steel automatic and manual dimensions use the dimension style that defines their appearance – color, 

format, text size, extension lines, etc. 

The configuration and use of those dimension style workflow is the following: 

 The Prototype stores the Dimension style with a set name. 

 In Management Tools, a specific set of defaults are configured to link Advance Steel to those dedicated 

dimension styles 

 During detailing, Advance Steel creates dimensions by using the dimension styles from the prototype. 

Configure dimension styles during Advance Steel prototype edit 

 Access the AutoCAD Dimension Style Manager dialog using the Advance Steel Change dimension style 

command. 
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 Create or rename dimension styles.  

The names set here will be further used in configuring the Default values inside Management Tools. 

 

 From the Modify tab, configure the selected dimension style with the specific required settings (text size, 

color, alternative units and so on). 

 Close the dialog and save the settings. 

Management Tools Defaults for Dimension styles 

Change those defaults to match the dimension styles from the prototype definition. They can all be found 

under the Dimension style category. 

Each different type of dimension (linear, arc, radial, angle and slope triangle) has its own dimension style 

specific default value. Multiple dimension types can use the same Dimension Style.  
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Automatic Views for Fabrication Drawings 

While evaluating the requirements for drawing styles, it is important to note what type of views are required. 

When considering the views that appear on a sheet, a combination of rules and settings are used that deliver an 

expected result. 

Drawing Style Definition 

Required views are referenced in drawing style definitions when creating the views. For example, a Beam – 

Assembly style for a generic beam drawing consists of 5 configured views, with more than 5 possible results. 

 

 A front view of the main element beam in the assembly. 

 A top view of the main element beam in the assembly. 

 A bottom view of the main element beam in the assembly. 

 Endplate views.  None, one or two views can be generated from this rule. 

 Automatic cut views, where you can obtain a varied amount of views. 

Necessary Views 

Click the Necessary View Wizard on the Object tab to open the Necessary View dialog which specifies when views 

appear.  

 

Each necessary view is conditioned geometrically if it appears or not during automatic drawing creation. 
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About Necessary View 

The Necessary view configuration is table based with a set of entries that map the view with a geometrical 

condition. A view will appear on the drawing if the condition set here is matched. Below is a fragment of an 

existing Necessary View configuration. 

 

The first line sets the Front View as Always show for any object. This means that regardless of the object geometry, 

the Front view will always appear if it is present in the Drawing Style configuration. 

The second line is for the Top View which denotes Non-straight shortening geometry. 

 

 

Each line has independent contrition and only one needs to be met per view for it to appear.  

Edit a Customer Profile for Necessary Views 

1. Click the Necessary View Wizard on the Object tab to open the Necessary View dialog  

2. Make the User category active. 
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3. Make the necessary modifications to the existing rules. By default this User category will have the same 

settings as in the Advance category which is the default configuration specific to the language and content 

installation. 

 Click Add to add new definition lines. 

 Select an existing line and click Delete to remove an existing line. 

 Change the Position of an existing line in the list with the arrow buttons. 

 

4. Click Apply to save the modification. 

5. To specify this modified profile as active, right click on User and select Set current. The active Necessary 

View displays bolded. 

 

  

Examples of Various Necessary View Requests 

In some cases, it may be required to not have any necessary view modifications in place, so each drawing style will 

output all of the configured views. Necessary views cannot be disabled with a setting; however it can be 

configured to force views to display every time. 

For this, a new profile is required, where all the existing views are present in the table, with the Rule column set to 

Always show. 

 

Another requirement that may be necessary is for Top and Bottom views to not display due to attached objects 

that define their geometry in that view. The primary cause being that the attached parts usually request a cut 

section to further define the positioning. To achieve this, delete any lines that refer to Attached. 
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Drawing Generation 

Before making modifications to drawing styles to match company standards, it is important to review the existing 

styles and use those as a starting point. Default drawing styles are configured to match most requirements with 

specific object presentations, labels, and dimensions configured based on country specifics.  

Review existing drawing styles by using them to generate drawings from a small model, created as a sample. Once 

the drawings are created modify them to match the requirements. 

Refer to this Complete Drawing Style Manager Guide for more information. 

For the most common workflows that can appear during a drawing style configuration – basic changes, use of 

drawing style copies and general information about the Advance Steel detailing mechanism, please review the 

following chapters. 

Drawing Styles 

Editing a Drawing Style 

When editing a drawing style, or adding a completely new drawing style, it is advised to use Copy (not Deep Copy), 

and reuse as many sub-functionalities as possible. Styles can be edited in the User category which duplicates the 

entire Advance category. After editing the User category, the original styles from the Advance category can be 

reused. 

All the existing rules, views, and presentations are reusable, so any edit can affect other drawing styles.  When 

editing or creating copies to start the work: 

 Never edit without creating/copying a rule. 

 Minimize the amount of copies, and reuse as many settings as possible. 

The following image highlights the structure layout of drawing styles.  

https://autodesksales.gosavo.com/Document/Document.aspx?id=37558372&view=&srlid=38498944&srisprm=False&sritidx=0&srpgidx=0&srpgsz=25
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Selected model objects, Presentation, and labeling strategy are core settings which directly communicate with 

Advance Steel, while the upper settings in the tree are saved rules that reuse certain configurations. Editing any 

settings of an existing drawing style requires a set of copies of the rules that are above that respective setting, 

including the drawing style itself. 

Note: The Drawing Style Manager does not mention on which drawing style a certain setting could be used. It is 

strongly advisable to select Warning on modifying a shared entity.   

 

Edit an Existing Drawing Style 

Below is a set of steps required to edit an existing drawing style. You create a copy of it and its hierarchy so none 

of the existing drawing styles that reuse the respective settings are modified during the process. 

As an example, modify the assembly part drawing style for a plate and its connected anchors. You can allow 

anchors from a trimmer plate to appear on the part drawing for annotation. 

The drawing style in this example is the 5-Plate assembly, from the 5-Assemblies category. 
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For this example, you need to modify the Object presentation rules for all the views in the drawing style to add the 

missing Anchor object.  

The workflow to add a new object in the Object presentation rule for anchor detailing involves the following 

modifications to the drawing style hierarchy.  

 New object presentation 

 New View 

 New Drawing style 

The modifications will need to be copied to ensure that no other styles are modified. 

When editing, the copies need to be completed from top to bottom. Starting with the drawing style, then the view, 

and ending with the object presentation. 

1. Make a copy of the drawing style.  

Note: Always use Copy instead of Deep copy. 
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The copied drawing style will keep the existing views and settings, so there is no difference between the 

two styles, except the name.  

2. Create copies of all views where the modification needs to be applied. In this case, those are the first 

three views: Top, Front and Section. 

 

3. Expand the Object presentation page for the first view and create a copy of it 

 

4. Add the Anchor presentation rule to this object presentation. 

5. Click Add a new object presentation.  

 
This will add a new line at the bottom of the list with values copied from one of the existing entries 

(generally the first line is copied). The object presentation rule will contain a duplicate entry. 
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The new line will store the necessary modifications to add the anchor object to the Plate drawing style. 

You can reuse existing configurations to add the anchor as they are core settings which do not require a 

copy. 

6. Specify the Model objects as Anchor bolts. 

 

7. Leave both the Geometric restriction and Depth position to All. 

8. Set Presentation to detail the anchors. For example set it to VisibleHidden which will detail the anchors 

with their full graphic representation. 

 

9. Specify a Labeling Strategy for those anchors under the Bolts category. If no label is required, select Off.  

 

 

10. Click Apply to save the settings. 

11. Repeat the actions from step 3 for the other two views. In each case, the Object Presentation rule should 

be copied and modified with the Anchor presentation. 

Note: Due to how the Drawing Style Manager can reuse certain options, it is important to check if the 

settings can be reused properly. In the example above, the Object Presentation rule for the second view 5-

Plate Assembly-Front is the same as the one already modified in step 4 for 5-Plate Assembly-Top. So 

instead of making a copy and making the modifications again, the modified rule can be reused by selecting 

it from the drop down menu.  
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Following the steps above, the drawing style displaying anchors will be part of the customer detailing database. It 

is created with only a small number of copies (5 in this case), with everything else being reused. This allows for a 

small database and avoids introducing unnecessary duplicates.  

Setting up the Relative View Arrangement 

The arrangement of views on shop drawings is dependent on a set of rules in the drawing style and further 

influenced by a default value set in Management Tools. The view arrangement rules can be set on a manual 

setting, where each view is placed relatively to the main view. It can be set automatically to use either the third or 

first angle rule. 

The main view is always the view placed in the first position in the drawing style definition list of views section. 

 

Set a View Arrangement Rule 

View arrangement strategies can be found on the View properties tab inside the View definition. 
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Because the View arrangement is a view property, the only two copies required in the Drawing Style hierarchy to 

allow a save modification of it are: 

 Copy the drawing style. 

 Copy the view. 

 Apply the modification to the new view. 

Only the style and the views get a copy. In order to change the Arrangement strategy, other items in the style 

definition are reused from the original 5-Beam style. 

 

 

View Arrangement Strategies 

There are two types of view arrangement strategies available in the Drawing Style Manager: 

1. Manual settings, where each view is positioned in relative position to the main view. 

Those options include settings like Below, Left, and Right that are all relative positions to the main view in 

the paper space. 

For example, in a beam drawing style, the Top view can be arranged at the Top, but when considering the 

same beam drawing style for a column with a vertical layout, the same Top view will be placed to the left 

of the main view arranged on the Left setting. 

 
The preview schematic below the view list determines where each view will be placed in relative position 

to the main view. 

 

 



                                                                                                  Advance Steel Implementation Guide                                                                                                                   
 

88 
 

 

 

2. Automatic settings 

This is configured by setting all the views on an Automatic arrangement. The automatic layout of the 

views is done based on the third or first angle rules. The used method is set by a global default value 

available in Management Tools > Defaults category. 

 

 US Standard is using the third angle project arrangement method, where 

o The Top view is placed above the front view. 

o The Bottom view is placed below the front view. 

o The End plate for the left hand side end of the beam in the front view is placed at the left of the 

main view. 

o The End plate for the right hand side end of the beam in the front view is placed at the right of 

the main view. 

 ISO (European) standard is using the first angle project arrangement method, where 

o The Top view is placed below the front view. 

o The Bottom view is placed above the front view. 

o The End plate for the left hand side end of the beam in the front view is placed at the left of the 

main view. 

o The End plate for the right hand side end of the beam in the front view is placed at the right of 

the main view. 

ISO (European) standard includes end plate views using the same method to arrange the views: first angle 

projection. It does also switch the position of the end plate views with the left hand side end of the beam 

end plate view placed at the right side of the main view. 
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Drawing Title 

The drawing title is a configuration specific to the drawing style, without any relation with the views. 

 

The title is configured through an integrated text editor that allows the use of tokens. Tokens are intelligent values 

that read and display object information in the title. The title can be configured to display the assembly mark for 

an assembly drawing, a quantity, or various user attributes associated to the main element of the detail. 

Cut view title 

At the drawing style level there is the option to control the way the cut view title will appear. The setting controls 

only how the cut view name will appear and will use the information from the symbol (e.g. the label name like A, 

B…1, 2) plus any other text. 

The cut view title configuration page offers the option to control the position of the cut view, and using a standard 

text editor, the content of the title.  
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By default the title configuration contains a name (Section) and a token that will display the value of the cut name, 

from the cut symbol.  

Other tokens can be added to form the cut view title, if needed. 

 

 

Labeling Strategies  

The automatic detailing labels placed on objects come from a set of preconfigured rules inside the Drawing Style 

configuration. An individual labeling strategy is applied for each different type of detailed object. The configuration 

is located in the View Object presentation tab and presents a table with object rules assigning a presentation and a 

labeling strategy. 
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For example, a beam can be detailed with  

 Visible presentation, detailing only the visible lines. This is suitable for isometric general arrangement 

drawings or node views. 

 VisibleHidden presentation, where both the visible and hidden lines are detailed. The two lines are 

detailed with different, controllable line types. This presentation is best suited for fabrication drawings: 

Part and Assembly. 

 Visible(Symbol)MedianLine where a small symbol of the beam is detailed along the object system axis.  

This is a standard presentation for schematic elevation and plan views,  

The object presentation also requires a certain order in which the lines are defined, allowing for a certain level of 

control over what objects, and with what labeling strategies are detailed on the sheet. When the list is used to 

create the drawing, Advance Steel goes from top to bottom in the list. 

When a rule matches a certain object type in detail, it uses it and ignores any other rules that apply to the same 

object.  

Identify which Labeling Strategies need to be modified 

Modifying the correct labeling strategy in the drawing style configuration based on a customer requirement needs 

a change in this object presentation rule after the line is identified. Identifying the line requires knowledge about 

the object itself and what type of object it is.  

 Is it a main element in an assembly or only an attached part? 

 Is it a beam, plate, folded beam, or folded plate? 

 Is it detailed from its Front, Side, Top or is it Isometric? 

 Does it have a specific model role in the 3D Model? 

Once those particularities are known, the line can be identified. The best way is to start checking each line, starting 

from No.1 and going downward. Some of the object filtering, like Model Role, requires expanding the Model object 

column, to check the object. 

The first line that is identified as matching all of the criteria will contain the labeling strategy. The configuration can 

match the requirements. The search can be stopped at this point, as Advance Steel will not go to a different line 

when detailing this specific object. 
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For example, in the Object Presentation list below, there are no labeling strategies for any of the detailed objects. 

Adding labels for anchors requires adding a Labeling strategy to line 17, as none of the entries above it refer to 

Anchor detailing. 

 

Add Labeling Strategies to the Same Class of Objects 

Often it is required to label, not label, or use different labeling formats for the same type of objects, but have a 

different structural role. 

For example, it is required to label shear plates on an assembly drawing but not label the stiffeners. 

Shear plates and stiffeners are the same class of objects in that they are attached plates and have a similar 

geometrical placement in relation to the main element in the assembly. The difference between the two elements 

is their structural role, which is specified in the Model Role object attribute field. 

 

In this case it is required to add labels only on Shear plates, while any other Attached Plate to the assembly does 

not have a label. It is safe to configure the drawing style to: 

 Filter out Attached Plates with the model role Shear plate and add a labeling strategy to them. 

 Have a second rule that details all attached plates, regardless of model role with no labeling strategy. 

The filtering rule is placed above the generic rule in the Object Presentation list.  

 It stops at the first line to filter out the attached plates with the Shear plate model role and sets the label. 

 It stops at the second line, where it details all the other attached plates except any with the model role 

Shear plate which were considered by the line above. 
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Labeling Strategy Rules 

Labeling strategies modified to move and add line priorities for additional filtering are all achieved inside the View 

Object Presentation rule. The minimum amount of copies to a drawing style is: 

 A copy of the Drawing Style 

 A copy of the View 

 A copy of the Object Presentation 

 

 

Edit a Label Strategy 

Configuring the drawing style object presentation rules requires selecting from predefined labeling strategies. If a 

new labeling strategy is needed for customer requirements, it will need to be created. 

Label strategy configurations are stored on the Labeling strategy tab found in the Drawing Style Manager. 

 

Select a labeling strategy that is similar to the one required and use Copy to duplicate it. 
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Start editing the Labeling strategy. 

Labeling strategies also have a two level of hieratical reusability. The duplicated labeling strategy is the top part of 

the editing dialog. 

 

The following characteristics of the label can be configured here: 

 Orientation of the label text. 

 Leader line – on/off. 

 Minimum distance for label combining rules. 

The other two segments of the label strategy shared between multiple labels are: 

 Label Content. The content of the label is edited through a text editor that offers the option of using 

tokens to evaluate values directly from inside the 3D model. Text formatting tools are also available. 

 Label arrangement strategies. 

Once complete, the label strategy can be used in any existing drawing style – object presentation rules. 
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Generic Example  
Make a generic configuration to a drawing with basic changes to its overall settings and modify 

the way objects are detailed and labeled  

This example showcases all the required steps to safely create new drawings by using an existing one as a 

template, and how to make all the necessary configurations to match the customer/project requirements.  

The example covers: 

 Creating drawing style copies that still use shared components with other drawing styles (to avoid the 

Copy of items that appear when using Deep Copy). 

 Explaining the position relative to the drawing style structure of all generic settings associated to a 

drawing style. 

 How to control the way objects are detailed – line-type, color, etc. 

 Changing the automatic labeling strategy. 

The example is based on the following customer requirement: Objects that have a different role in the model 

should be printed with a different line-type, and also have a different labeling strategy.  

To control the line type different objects have during plotting you need to follow a two-stage process, which 

involves the following workflow: 

1. Detail the different objects using different colors – this is setup through the drawing style. 

2. Plot the different colors using a specific line type (e.g. Zigzag, Hidden, or Dashed) – this is setup through 

the plotting .ctb file. 

Using this workflow it is possible to plot two beams detailed as visible, but with different structural roles and with 

two different line types. This configuration does not apply to the DWG file (where the difference is only the used 

color). The configuration applies when sending to any type of plotting (PDF, paper), the CTB file will control the line 

type. 

Step 1: Assign a different line color to each different object type for which you need to 

control the plotted line type. 

Sample model and drawing style: an elevation view on a support beam and a railing. 

 The beam has the Beam model role. 

 The railing has the Railing Handrail Landing model role. 

 The drawing style used for this sample is 3-Elevation View – Line, from the U.S. Installation (Advance Steel 

2017): 
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1. Open the Drawing Style manager, browse to the drawing style and access the Objects presentation view 

tab: 

 

2. A common drawing style will not have specific filters for dedicated model roles. Most of the beam 

elements are detailed using a common rule – Beams, with other specific roles being either ruled out, or 

controlled by dedicated rules. 

In this example, for the two model roles, two new rules need to be added in the list: one for the beams 

with the Beams model role and another for the top handrail. 

 

3. Adding a new rule: when adding a new object presentation to an existing drawing style, the style itself is 

modified. At this point you can either change the default style – but you might risk changing another 

drawing style that uses the same shared settings, or you can create a copy of the necessary settings, and 

obtain a new drawing style that still shares settings with other styles, but has individual settings 

specifically targeting the areas of interest. 

In this example, a new drawing style is created, and the shared settings that need to be cloned are view 

and object presentation. 

 

a. Create a copy of the drawing style using Copy from the context menu: 
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b. Access the View properties of the copied drawing style, and use (New) to create a new view. 

 

c. Access the Objects presentation category of the new view and create a new object presentation rule: 

 

d. Once this step is done, you have a new drawing style that uses a new view, with a new object 

presentation and any changes made to this object presentation will not affect any other existing 

drawing styles. 

 

4. Add two new object presentations. 

 

The two new rules will be added to the end of the list and they will be a duplicate of the first rule – will 

get changed as part of this configuration. 

5. Configure the object presentation to match the requirements. Double-click on the line to go to the more 

advanced view of the configuration. 
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a. Model object: This option will control what object from your model will be detailed by this specific 

line. As part of this configuration is to match specific model roles, those model objects need to be 

selected to match the object type (beam, plate, etc.) and model role. 

Search through the list and select the required model role. Out of the box Advance Steel provides a 

wide series of pre-configured model objects. The model object for beams with the Beam model role 

exists and it is named Mp – Beam (model  role). 

Note: Mp is short for Main part, so this model role will also act as a filter for main parts in assemblies. 

 

 

If the model object pre-configured as required does not exist, it can be added. 

For example, the model object for the Railing Handrail Landing model role is not available, so it needs 

to be added as follows: 

 Use the Set button next to the Model object category to access the configuration page: 
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 Create a new Model object using the (New) button: 

 

 

 Configure the Model object and Model role fields as needed: 

 

b. Presentation rule: Set both new object presentation rules on SingleLine: 

 

c. Set a Labeling rule if needed. 

 

6. Once you finsih the previous steps, you obtain two new object presentation rules for the two model roles, 

both with a SingleLine object presentation: 

 

The SingleLine object presentation will detail both elements using a single line, with the default red color. 

In order to control the color of the two rules, you need two new object presentation rules, based on the 

SingleLIne rule – but using different colors. 

7. Access the first object presentation rule – for Beam – Railing Handrail Landing (model role), and use the 

Set button for the Presentation rule category to open the Presentation configuration panel. 
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The default SingleLine presentation, found in the out of the box installation, is configured with the Single 

line element set on the default color – which means Advance Steel will use the color set in the 

Management Tools defaults for Single Line objects. 

8. Create a new Presentation rule using the (New) button. 

 

9. Expand the Color column combo-box for the Single line element and select a different color (e.g. Green). 

 

Note: If more colors need to be added, please check at the end of the document the steps required to add 

more presentations to this list – including more colors that can be used during detailing. 

10. Repeat the steps for the other model object (Mp – Beams (model role)) and create another Single line 

presentation rule, with a different color. 
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11. Once the two object presentations are added, they need to be positioned in such a way that Advance 

Steel will prioritize them when detailing the objects. This is required because the object presentation list 

starts detailing objects from number one and goes downwards. 
 

 
 

Once an object is detailed by a line, then it will not be detailed by other lines after it – even if the rule 

matches the object. For example, if at position 20 you have a rule detailing all Beams, regardless of their 

numbering type or model role, then the rule we configured at position 40 to detail the beams with the 

Beams model role and a blue Single line will be ignored. However, if you move the new rule ahead of the 

20th line, then Advance Steel will detail all beams with the model role Beams, using the dedicated 

presentation rule, and then when it reaches position 20 it will detail the rest of the beams (that don’t 

have the Beam model role) with the respective object presentation. 

 

In this case, the two new object presentations should be moved at positions 3 and 4. 

 

 
 

Detailing this small sample model with this drawing style will result in a drawing with two lines: a green 

line for the Railing Handrail beam, and a blue line for the beam: 
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Step 2: Use the line color to control the plotting line type, through the AutoCAD plot CTB 

configuration file 

When plotting an Advance Steel drawing using the AutoCAD plot functionality, the way each line is plotted is 

controlled independently from the way the drawing looks when open in Advance Steel through the CTB file – a 

plotter assigned set of rules, which can be edited, saved and reused as needed. 

Advance Steel comes with a default ctb file called AdvanceSteel.ctb, found in C:\ProgramData\Autodesk\Advance 

Steel 2017\Shared\Support path. 

 

Changing the plotting strategy: 

1. Open the Plot Setup Manager dialog by right clicking on the ANSI Advance Steel layout and choosing the 

Plot Setup Manager option. 

 

2. Use Modify on the Page Setup Manager dialog to access the page setup dialog: 
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3. The page setup dialog provides the option to control the way the current drawing is plotted; this setting is 

saved per DWG file. This can also be done directly in the prototype (using the same steps to access the 

Page Setup dialog), allowing Advance Steel to produce all the drawings using the same settings. 

4. Select AdvanceSteel.ctb from the combo-box on the top-right side and access the Edit page: 

 

5. The Plot Style Table Editor dialog offers the option to map the color of various lines on the drawing, with 

how they are plotted. 

 

On the left side of the dialog, under Plot styles, all the colorline that can be assigned are listed. New colors from 

the DWG can be detected as well, if used. 
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On the right side there are the properties of how the respective color line will be plotted. By default, almost all the 

colors are configured to be plotted with the Linetype set on Use object linetype – so the linetype will be read from 

the DWG, but if needed, the linetype can be controlled and a dashed single line from the drawing can be plotted 

with a continuous line. 

Adding more color values to the Object Presentation configuration table 

You can add more color values to the object presentation rule configuration, by editing a database as follows: 

 
 

1. Open the Management Tools, and access the Table editor feature. 

2. Use the top-left button to load the databases. 

3. Browse to the AstorDetailsBase database and open the DetAcadSettings table. 

 

4. Scroll to the end of the table, and add a new line with the following values: 
a. Key – this requires a unique number – preferably a value that is consecutive with the last entered 

one. 

b. RunName – the name of the color. This value will appear in Drawing Style Manager, when editing the 

Object Presentation rule. 

c. Color – the value associated to the required color. The table supports color codes from 1 to 256. To 

easily find what number is associated to each color:  

 In Management Tools, access the defaults feature. 

 Browse to any category that contains defaults which set a color (e.g. Drawing-

Presentation / Colors). 

 Click on the property value of any default to see the color table. Hover the mouse over 

various colors and check their Index color value: 
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d. Layer and Linetype: leave them empty. 

e. OwnerText: use the current Author/Owner value from the combo-box.  

 

After making the modifications, make sure to restart Advance Steel for the setting to apply in the Drawing Style 

Manager. 

 

Change the labeling strategy for the two new lines 

In the object presentation page, for each line that associates to a model object – the filter that has the role to 

detail a specific object from the model – with an object presentation – the style, line-type and color used by 

Advance Steel to detail the object, there is also a column that can be associated to a labeling strategy. 

The labeling strategy handles the rules that Advance Steel uses to create a label on the respective object, with the 

content of the label using real information about the object, the graphic appearance and the 

orientation/positioning on the drawing.  

You can assign labeling strategy using the combo-box available when clicking on the cell. 

Advance Steel comes with a large variety of preconfigured labeling strategies that can be reused at any point: 

 

Because at the previous step a new object presentation rule was created, changing and reusing existing labeling 

strategies will not affect any existing drawing style configurations, and it will only apply to the newly configured 

drawing style. 
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Modify or creating a new labeling strategy 

It is often required to make small modifications to existing labeling strategies, or create new ones. For 

any required modification, you need to follow a certain number of steps to ensure that the change is 

well recognized and used only where it is intended. 

As the labeling strategies are shared, making a modification to one of them will transfer to any other drawing style 

that uses the respective labeling strategy. Because of this, there are two scenarios: 

A. I want to modify all my labeling strategies for this specific label, because I use a different font for my label text. 

In this case, the shared functionality of Advance Steel labeling strategy is very efficient, as the change in font 

type can be done only once – and automatically transferred and used by any drawing style. 

 Open Drawing Style Manager and access the Labeling strategies tab: 

 

 Make any modification regarding the labeling strategy to any of the items in the list.  

Note: In this view, the Drawing Style Manager will NOT display in which drawing style those strategies 

are used. 

 
 

B. I need to modify or create a new labeling strategy that I will use only for a specific drawing style. 

For this case a new labeling strategy needs to be created. The labeling strategy tab is split into two parts – so 

depending on which part needs to be modified, the workflow is different: 
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The First half of the page contains generic information about the leader line, text direction and orientation. 

 

These settings are part of the labeling strategy itself, and are not connected to the content of the label. 

Create a new labeling strategy by using the (New) button 

 

Once created, use drag and drop (click it, hold the left mouse button and move) to move the newly created 

labeling strategy to a different category, if needed. 

 

Make the necessary modification. 

The second half the page contains the content: 

 

These settings are also shared, so you can have a different labeling strategy using the same content rule. 

Therefore, if the change is needed here, you need to: 
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 Create a new labeling strategy as mentioned in the previous step (even if no modifications are 

required). 

 Create a new label content rule. 

Create a new label content rule: 

Use the (New) button 

 

The content of label rules does not have categories; the label rules will be listed in the combo-box 

alphabetically. 

Set the Used for object setting according to the object where the label will be used. There is an All Object 

setting as well for a more generic rule. 

Make the content configuration change according to the requirements, using the label editor. 

- Change label format  

- Use Tokens to display updated information about object parameters 

- Text format 

Label arrangement rules: 

The last point on the label strategy page is the label arrangement. This is separated from the label content, and it’s 

under the label strategy – so when a change is needed only for this part, the label strategy needs to be copied as 

described at the first point. 

 

Chapter VII – Detailing Processes 

General overview of Advance Steel processes 

To facilitate a faster detailing process and generate all the relevant drawings in an automated way, Advance Steel 

provides the Drawing Process functionality, configured and applied using the Drawing Process Manager.  
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You can also access and use the drawing processes using the shortcuts added on the Drawing Process Palette: 

 

An Advance Steel process is an advanced rule which selects objects from the model and details those objects using 

pre-configured drawing styles. The drawing process also has information about the batch creation of drawings and 

is able to reuse prototypes and automatically number and scale the drawings to fit. 

Main reasons to configure a drawing process during Advance Steel 

deployment 

When creating an Advance Steel deployment to fit the customer standards, processes are often required to be 

modified to match the requirements. They do not contain the actual style configuration – so this step should be 

done before going to processes, but they do offer enough flexibility to automate the drawing generation process 

even further. 

The reasons a process may need to be adjusted by a company: 

 Prototype used for detailing: Often a company will create new prototype with the company logo and 

other format characteristics which will use a different name than the out-of-the-box one.  

 Different drawing styles in the detail style map: When new drawing styles are created with customer 

specifications, the process needs to be adjusted to match. 

 Custom scales: Processes have the ability to ignore the drawing style scale, so if a custom specific scale 

needs to be used automatically, it needs to be changed in the process 

Create and customize a drawing process 

The example below will go through the steps required to create a new camera process that uses different 

prototype, drawing scales and custom-made drawing styles.  

1. Open the Drawing Process Manager and go to the User category > 1 - Cameras. 
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2. Select any process, right-click and use Copy. Set a new name for the customer process.  

 

 
 

Note: the page size name in the process title is not relevant when choosing which process to copy. This is 

only a reference the page size of the prototype used, which is easily modified afterwards.  

 

3. After the copy, the name of the process on the left-hand side will be different from the name of the main 

step. This happens because the process is only a shell that holds a set of steps, which are, in the end, 

responsible for detailing. Each process has a main step, and some additional steps (if needed).  

To continue editing the process, a new step needs to be created, with a new name using the  (New 

step) command. 

 
 

4. Configure the required process adjustment in the Main step, as follows. Each of those configurations is 

independent from one another so, based on the requirements, only some of them need to be done: 
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a) Object selection: The first part of the step refers to the object selection. This is the selection tool 

Advance Steel uses in the model to select the objects that take part in the detailing process. For 

cameras, the model object rules are called “…..Cameras….” with the following prefixes/suffixes: 

 

Prefix: All and Selected cameras. All will select all the cameras, while Selected will work with a 

preselection of objects before using the process creation command.  

Suffix: Anchor, Node, Roof, etc. Those are the camera types (configured from the 3D Model camera 

object), which help with filtering. 

 

 
 

Those filters are very important because they allow the creation of various cameras, for different 

parts of the structure where the drawing styles need to be different. Therefore, by using those filters, 

the configuration can assign specific drawing styles to certain camera types, allowing for an 

automated detailing process of all cameras without the need to preselect them and match them to 

certain drawing styles (able to handle the respective detail drawing requirements).  

 

b) Detail drawing(s): Filename selector. This configures what prototype is used by the process and the 

automatic naming rules of the drawings. 

To change it: 

o Click the  (Properties) button next to the Filename selector drop-down. 

 

o Create a new filename selector rule using the Copy button. 

 

o Type the prototype filename (as found on the hard drive) in the prototype box: 
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o Choose the desired Close page setting. 

This is a rule that configures how Advance Steel creates the next sheet during detailing. The 

setting is mainly useful when configuring shop drawing processes, but will also partially work for 

camera processes. 

This rule has the following settings: 

 On page full: Advance Steel will start a new sheet once the previous one has been filled 

with views. Therefore, if the combination of paper space and size of the view is enough 

to allow multiple views to be created on the same sheet, using this option Advance Steel 

will be able to do so and create multi-view sheets. 

 On next object: A new drawing sheet will be created for each object, regardless of their 

type – it can be a part drawing, an assembly drawing or a camera view. 

 On next main part:  A specific setting that can be used when creating processes that 

detail the assembly drawing and all the single part drawings for the attached parts. 

Using this setting will allow Advance Steel to create drawing sheets with the assembly 

drawing and all the single part drawings that belong to that assembly. 

o The Drawing name setting controls how the drawings are automatically named during creation. 

 

 
 

The configuration is done by using a text style box, where you can write text and you can also use 

tokens to automatically name the drawings using specific object attributes. You can choose from 

the available tokens by clicking on the right-side arrow button. 
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Note: An important mechanism to note when configuring the automatic drawing name is the 

necessity of a unique number, one that does not allow Advance Steel to create drawings with 

identical names. This mechanism is applied by using the %Flat and/or %SequenceNumber tokens. 

At least one of the two tokens needs to be used, otherwise an automatic %Flat token will be 

applied at the end of the token, one with six decimals (e.g. 000001). When the %Flat token is 

inserted in the Drawing name configuration it offers the possibility to control the amount of 

decimals, using the number between brackets located at the end of the token – e.g. %Flat(03) 

means that the token will create a drawing number value such as 001,002. 

 

c) Scales: As part of the automated process, a set of scales (that Advance Steel uses when trying to fit 

the drawing on the paper space) is configured using the Alternative scales process configuration tab: 

  

Here you can select multiple scales that Advance Steel will use through the following mechanism: 

- If the scale configured in the drawing style is also part of the process configuration, Advance 

Steel will prefer to use it, unless the created drawing doesn’t fit the selected process. In this 

case, Advance Steel starts to use the other alternative scales set in the process, aiming for a 

smaller scale than the drawing style one, until it finds a scale that makes the view fit the 

page.  

- If Advance Steel cannot find a scale that fits the view, then the view will be created 

automatically using the drawing style scale (even if it does not fit), and the process will 

continue detailing the next object. When this happens, the process automatically ignores the 

Close page setting, creating a new page for the next detail – because the drawing that did 

not fit before is considered to have already filled the entire page. 

 

d) Drawing styles – Detail style map: This is the main configuration of a process that assigns a 

designated drawing style to each detailed object. 

To access the Detail style map configuration,  (Properties) button: 

 

 
 

Create a new style map to start configuring it: 
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The detail style map is a simple tool that creates a rule connection between the model object and the 

drawing style you want to use to detail that specific model object. In the camera process case, this 

rule is created between model objects that represent the different camera types in the model, and 

drawing styles specifically configured to create dedicated drawing for each case. For example, in the 

following image, the Camera Anchor type is assigned to an anchor plan drawing style, while the 

Camera Roof type is assigned to a plan view drawing style. Using this configuration the process can 

become a good all-around detailing tool that will create details for the entire model, with only one 

click. 

 

 

 
 

 

Process - Additional steps 

The main configuration tab for a process is the main step, the main window that appears when accessing the 

Drawing Process Manager. But, as mentioned above, this main step is an individual step itself – shared between 

multiple processes.  

To make the configuration easier for those shared steps, the Drawing Process Manager offers the option to 

configure the step directly:  



                                                                                                  Advance Steel Implementation Guide                                                                                                                   
 

115 
 

 

The Additional steps functionality (visible during process configuration) has the role to add multiple steps to the 

process workflow, steps that are accessed when the main step does not find a match in its configuration. 

 

The main reason a process step does not find a match during detailing is the scale. As mentioned above, if, when 

detailing a view, none of the scales set in the Alternate scales configuration dialog will generate a drawing small 

enough to fit the prototype layout, Advance Steel will just create a drawing using the default scale – even if it 

exceeds the paper space. 

Using an alternative step can mitigate that, by having a step that uses a larger prototype, so as the process will be 

able to fit the view on it using the combination of alternative scales and layout sizes. 

This means that with an additional step a process will: 

- Create most of the drawings using the configuration from the main step – prototype size, scales, drawing 

name and detail style assignment. 

- Mitigate the cases when the view is too large to fit the preferred prototype by using a larger page size.  

Chapter VIII – Configuring Bills of Materials 

General overview of Advance Steel Bill of Materials 

Advance Steel can create two types of Bills of Materials: 

 On drawing - a list using CAD-based graphics, inserted on the drawing and listing all the objects present 

only on the respective drawing. 

 External lists - by default exported to the RDF format (with the option to further export to PDF, XLS, etc.), 

which can use information from the entire model, or can be a model selection-based list. 

External Bill of Materials  

External Bills of Materials are created from the model, using either the BOM templates palette or the BOM Editor. 



                                                                                                  Advance Steel Implementation Guide                                                                                                                   
 

116 
 

The palette is a quick access tool to the BOM Editor templates. Editing the templates is done only in the BOM 

Editor. 

 

See more information about how to edit the templates, in the BOM Editor topic. 

Important to note when editing BOM templates: 

 When creating a new list, always start the Copy from an existing list that has a similar layout. For example, 

if you need a new material list that has different graphics, some different attributes and a different way to 

filter the objects, start the copy from an existing material list.  

This is required because certain sorting rules are embedded in the list, and cannot be duplicated with an 

external setting. For example, the grouping functionality of structured lists is particular only to those lists, 

and it cannot be set to a beam list. 

 

 The token edit of the BOM editor is graphic, using a set of rectangular cells that can be of any size. If you 

need a template that eventually gets exported to Excel, the graphic configuration of the list needs to 

match the Excel cell-based appearance, with equal width cells per column. When editing the template you 

need to edit all the blocks, including the header. A big logo picture (one individual cell) will not be 

correctly exported to Excel in relation to the cells below it, so it is recommended not to use it for this type 

of lists. 

 

 Some of the tokens may not work for every list, this depends on the type of the configured list.  

A common case is the difference between object lists (such as the Material List, Beam list, structured lists) 

and the drawing lists (listing the detail drawings created and registered to the model at any point). These 

two types of lists are independent from one another, and their information cannot be mixed. Therefore: 

o Drawing lists cannot get detailed information about the objects (e.g. beam length, beam user 

attributes, material and so on). 

o Object lists cannot display the drawing information (e.g. an Assembly List you cannot contain the 

drawing number reference next to the information about the assembly). 

Transferring BOM templates 

BOM templates configured with the BOM Editor are stored in a database as follows: 

 The Advance category templates are stored in the AstorProject.mdb (c:\ProgramData\Autodesk\Advance 

Steel 2017\Kernel\Data\) 

 The User category templates are stored in the AstorAddIn.mdb 

As the User templates are stored in AstorAddIn.mdb, their conversion to a newer Advance Steel version is done 

very easily, by copying of this database – a step needed anyway as part of the merge process. 

The BOM Editor offers two more options to transfer configured templates: 

http://help.autodesk.com/view/ADSTPR/2016/ENU/?guid=GUID-8B0248A4-4767-4CF0-881C-3EB60C1849A4
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 Import templates and Export templates, that can be accessed  by right clicking on the templates in the 

tree-view:  

 

 The Project category: this allows you to save certain templates in a small database associated to the 3D 

model, allowing a quick transfer of the BOM template together with the model to a different user – 

without the need to use import/export, or to share the database. 

The Project category exists in the BOM editor at any point, having a folder-based structure that is empty. 

 

 
 

Using the Project category 

 Copy any templates from the Advance or User categories to the Project category, using the Copy template 

option. 

 Choose Copy to Project database: 
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 Once the template is copied, notice that a new database appears in the project folder, next to 

the model. The  new database has the same name as the model. 

 

This database stores the Project BOM templates. Therefore, in order to utilize this functionality 

when transferring the model / Advance Steel project to a different user, this database also needs 

to be moved. If the database is not moved, then you will not see the Project category. The 

Advance Steel project itself will not be affected in any way, and you can create additional lists 

from it using local BOM lists. 

Example: Changing the company logo of existing BOM templates 

The following example is a simple and common configuration of BOM templates and how to change the company 

logo during the Advance Steel deployment. 

You can change the company logo on existing templates without the need to create new ones: 

 Open the BOM Editor. 

 Select any template from the list. 

 Click the existing logo to select the picture content rectangle. 

 From the right side properties sheet, click on the “… “ button, next to the Image property. This will open a 

Browse dialog, which will ask you to select a picture from the disk. 
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 Once the new logo is selected, it will replace the existing one. Make the necessary scaling actions if 

needed (the picture will be automatically scaled from any resolution to fit). 

 Save the template. 

This action needs to be repeated for each template that will be used by the respective company.  

Bill of Materials on drawings 

The templates used by Advance Steel to generate on-drawing lists are .dwg based, and are found on the hard-drive 

at the following location: c:\ProgramData\Autodesk\Advance Steel 2017\Shared\Support\BOMTemplates\ 

Editing them is done with Advance Steel, using a combination of Advance Steel and AutoCAD commands, as 

described in FAQ: How to customize a BOM on drawing template?  

Transferring BOM on drawing templates during migration to a newer version is done through a simple copy of the 

files on the disk. Once copied, it is recommended to open each template with the newer Advance Steel version and 

perform a simple save to convert the files to the newer version.  

Chapter IX – GUI Customization 

The Advance Steel Tool Palettes 

The Advance Steel tool palette offers a wide range of configuration possibilities from changing the layout to adding 

new commands or shortcuts. 

To modify the tool palette layout, enter the edit mode holding the right mouse button while hovering over any 

button on the tool palette.  When the edit mode is active, the icons will change and move:  

http://help.autodesk.com/view/ADSTPR/2016/ENU/?guid=GUID-AE98D7EA-0C09-49AF-ACFE-6A36E3E7FB20
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Editing is very easily done by using dragging and dropping the icons, moving them around the current category or 

changing the category by dragging them on top of the category tab button on the left side.  

You can also add new commands in the edit mode, by using the + button available in the top of each tab. 

 

Adding the command is done using a simple dialog, containing the following options:  

 

Name: the name of the command that will appear as a tooltip when hovering the mouse over it in the tool palette. 
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Picture: Here you can select a picture from the hard drive and use it as a background for the new command.  

Command: the Advance Steel command to which this new button will point out. Its format should be similar to the 

way it appears in the command line when using the command. 

For example: if you need a new button to apply the User category Quick Connection, for which there is a button 

only to apply the Advance category settings, you need to create a new button and fill out the command as follows: 

_AstorAutoConnection 1 1 

The difference from the existing Quick Command button is that now the Key is 1 1 , instead of 0 1. The change from 

0 to 1 means that the command will now apply the User category settings, instead of the Advance category ones 

which use the 0 key. 

 

The Advance Steel Drawing Styles/Processes/BOM Templates Palettes 

For quick access to the preferred drawing styles / processes and BOM templates, Advance Steel offers three 

palettes: 

 

These three palettes have a back configuration that tells them which style/process/BOM is displayed and also what 

picture and comment it should display in the preview tab. 

Changing those require a set of steps that involve the Drawing Style Manager/ Drawing Process Manager/BOM 

Editor, and editing databases. 

Add or remove styles/processes/BOMs for the User category 

As the User category is mainly used to configure customer content, this tool palette category should also be edited 

to provide a good quick access tool to the custom content, which will be used during the project workload. 

Drawing Styles / Drawing Processes 

1. Open the Drawing Style Manager or the Drawing Process Manager. 

2. Go to the User category and select any of the sub-categories. 

3. On the right side there will be a list of styles/processes found in the category, each having a checkbox 

which sets their visibility in the tool palette. Unchecking it will remove them, while checking it will add 

them to the Drawing Style / Drawing Process tool palette. 
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BoM templates 

1. Open BOM Editor. 

2. Go to User category and select any of the sub-categories. 

3. On the left side the list of templates in that category will appear, each list item having a checkbox that 

sets the visibility status of each list in the tool palette. 

 

Categories are added/removed based on their requirement in the tool palette. If a category from the Drawing Style 

Manager has no styles present in the tool palette, then the category itself will not be listed. 

Important Note: in order for Advance Steel to refresh the change done in either of the editors (to show the newly 

added styles), follow these steps: 

- Do your editing in Drawing Style Manager/ Drawing Process Manager/BOM Editor (add/remove items 

from the tool palette).  

- Click Apply and close the editor. 

- Close the tool palette using the X button: 
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- Close Advance Steel and start it again. 

- Open the tool palette.  

Switching between Advance, User and Country add-in 

 

The Drawing Styles/ Drawing Process / BoM template plates offer visible at one point only one of the categories 

between Advance, User and , if loaded, country addin. To access for example the drawing styles/processes or BoM 

templates edited in the User category, the palette active category needs to be switched between the default 

“Advance” to the “user” category. 

To make the different categories visible, those tool – palettes have a small button that allows the switch between 

those categories. 

 

A simple click on this toggle button with make the switch, with the icon representing the current category: 

- “Country flag” icon associated to the Advance Steel installation language and content represents the 

“Advance” Category 

- Generic user picture represents the User category.  

If the Advance Steel installation has active at least one of the external country add-ins, which gives access to 

drawing styles found on different language and content installations (e.g. “UK” drawing styles made available in an 

“US” installation), then the button will change its functionality between a toggle that cycles between “Advance” 

and “User”, and it will offer instead a small list with all the country addins and the “Advance”/”User” category, 

making the switch very easy and fast. 

 

Restoring the palettes to their original state 

If at any point you need to restore the palettes to their original form, you need to delete the XML file that contains 

their configuration – in this case the original, unmodifiable XML file will be used instead. 

The way the palettes are created and populated with data is the following: 

- When Advance Steel is installed, a set of .xml files associated with the palettes are installed in the 

following folder: c:\ProgramData\Autodesk\Advance Steel 2017\Steel\Support\Toolbars\ 

Each palette has an associated .xml file:  
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 Drawing Style Palette: AstDetailsData.xml 

 Drawing Processes Palette: AstProcessesData.xml 

 BOM Template Palette: AstTemplatesData.xml 

 Tool Palette: AstPaletteData.xml 

Those files are only used as templates, because when Advance Steel starts for the first time, each of them 

will be cloned (in the same folder), and Advance Steel will use that .xml file instead. 

The cloning process is done by doing a simple copy of the files and adding the _user suffix to the file name 

which results in: astdetailsdata_User.xml, astprocessesdata_User.xml, asttemplatesdata_User.xml and 

AstPaletteData_User.xml. 

So, if any of the palettes need to be reset to the original settings: 

- Close the respective palette from Advance Steel, using the X button. 

- Close Advance Steel. 

- Delete the _user .xml file associated to the respective palette. 

- Start Advance Steel and open the palette.  

The original xml file is cloned again to a _user file, and is used instead, resulting in a set of clean settings. 

Migrating the palettes or sharing custom configurations during deployment 

As previously mentioned, all the settings made by the user in the palette configuration – layout, commands, 

arrangement (for the Tool Palette only) are  stored in a set of files found in c:\ProgramData\Autodesk\Advance 

Steel 2017\Steel\Support\Toolbars\ 

To migrate those settings to a newer version, or to easily deploy a set of configurations made to match the 

customer requirements, you need to copy those files (the ones with the _user suffix, which are the ones that 

Advance Steel actually uses) and use them on each computer that needs the respective settings. 

The files are:  

 Drawing Style Palette : AstDetailsData_user.xml 

 Drawing Processes Palette : AstProcessesData_user.xml 

 BOM Template Palette : AstTemplatesData_user.xml 

 Tool Palette : AstPaletteData_user.xml 

 Connection Vault Palette : Connectionvaultdata_User.xml  

Chapter X - Advance Steel - Vault Integration 

Advance Steel with Vault Workflow 

Starting a new Advance Steel project integrated with Vault 

This section describes the steps required to start a new Advance Steel project and to integrate it directly 

in Vault and use Vault to manage the deliverables – drawings, NC files, bill of material lists, etc. – created 

from the 3D model.  
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Before starting the new project, the Vault client needs to be configured with a proper working folder 

path on the local computer. This folder will be used to store the local copies of the files and it is 

important because it will in the first stage to store all the created deliverables and will also ensure a 

coherent workflow with other products where the Advance Steel model is used as reference.  

To configure the working folder: 

1. Start the Vault client using the desktop shortcut. 

 
2. Select the project. 

 
3. Go to File > Set Working Folder… 

 
4. Choose a folder on the local machine. This folder will then be used as a mapped folder to the 

Vault container root path. 
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Adding a new Advance Steel model file to the Vault server 

1. Start Advance Steel and connect Vault using the dedicated ribbon tab. 

Note: If the Vault automatic login setting is used, this step is not necessary. 

 
2. Create the Advance Steel project. 

3. Save the file to a local path. 

The file can be saved in any location on the disk. When you add the file to the Vault project, it 

will be copied to the local working folder, configured in the Vault client. 

If the file is saved directly in the Vault local working folder, Vault will no longer request the 

definition of the Project Folder Structure and will allow more flexibility on the folder and 

location of the file within the project structure. 

4. Use the Check In command to add the Advance Steel model to the Vault project. 

 
 

 If the file was initially saved in the Vault working folder – in this case, Vault will proceed 

to adding the file directly to the folder substructure, based on the working folder. 

 If the file was saved in a different location on the local drive – in this case, Vault will 

request the Vault project location where this file should be added. 
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You can create folders in the Vault project from the Select Vault Location dialog. 

Once the folder is selected and the check-in is complete, Vault will: 

 Add the file to the project. 

 Create a local copy of the project in the Vault working folder. 

 Open the respective copy to continue working with Advance Steel. 

The initial location where the file was saved will no longer be actively used by this 

project, but the .dwg file will remain there in its initial state. 

 
5. Use the Check Out command to use the file as a current Advance Steel user and continue 

working on the project. 

The local file in the Vault working folder becomes editable and the Save command becomes 

available for the local copy. 

When work needs to be updated in the Vault project, use the Check In command, followed by 

the Vault workflow. 

 

Creating documents from the Advance Steel model and adding them to the Vault project 

Because Advance Steel works with the model file in the Vault working folder, this will generate all the 

detail drawings, bills of materials, NC files and other deliverables in the relative folder, next to the 

model. 

These files and folders are not automatically added to the Vault project. To add them to the Vault 

project after they are generated: 

1. Use the Check In Folder option from the Vault Server settings menu, under the AutoCAD start 

menu (this command is not on the Vault ribbon tab). 
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2. Under Folder Location, browse to the Vault working folder location where the latest version of 

the model is and where the local copies of the deliverables were generated. 

 
3. Before the check-in is over, Vault displays a list of files that were added to the Vault project – 

the files are grouped in folders: 
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Note: The File Locations options in the Settings windows needs to be set on “Use organized 

folder structure”. 

 

 

4. To add extra files from the Advance Steel model to the Vault project – files that were generated 

in later stages, use the Check In Folder command as described in step 1. 

During the scanning stage, Vault identifies and marks only the files that are new in the local 

working folder but not yet added to the Vault project. 
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The existing files are ignored and are not shown as an option to be added back, during this 

command; they will remain in the Vault server project and be used as intended for further 

actions. 

 

Updating drawings after model modifications 

An important aspect of working on an Advance Steel project is to apply model changes to existing 

drawings, using the drawing update. The generic workflow for this action is to perform the update 

having both the model and the drawings checked out on the local machine where the model was 

modified and then check back all drawings into the Vault server. 

1. Modify the model: 

 Check out the model on one of the stations using Advance Steel. 

 Copy the latest versions of the drawings from the Vault server (using the Get command) 

to ensure that the Document Manager displays the correct status of the drawings, after 

the model modifications; the drawings don’t necessarily need to be checked out. 
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2. Open the Document Manager. In the Document Manager, based on the changes made in the 

model, some drawings will enter in the Update required category. Because the drawings exist on 

the local computer, even if they are not checked out, Advance Steel can identify which drawing 

needs to be updated. But, as files not checked out from the Vault are in a read-only state, they 

cannot be updated. Using the Force Update command will not change the “update required” 

status of the files, as changes are restricted by the Windows read-only state. 

 

3. Check out the files that need to be updated. To perform this operation, use the Vault client, 

started separately. The AutoCAD Vault plug-in will not be able to check out the Advance Steel 

drawings as required by the Advance Steel drawing update functionality. 

 

There are two methods you can use to the files for update, followed by check in: 

Method 1: Check out all the drawings from the Details folder in Vault: 

a. In Vault, browse to the Details folder associated to the Advance Steel model and use Select All to 

select all the DWG files and their associated UPD files. 

b. Right click and use the Check Out command. 
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c. Return to Advance Steel and open the Document Manager. 

d. Update the drawings using the normal Advance Steel workflow – directly from the Document 

Manager or manually from the drawing level. 

e. Use the Check In Folder command in the AutoCAD menu: 

 
f. In the Folder to Check In field browse to the Vault working folder – where the local copies of the 

Advance Steel files are stored. Select the Documents folder and click OK. Add a comment, if 

needed, for Vault workflow references (e.g. Assembly B1-3 section size changed). 
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g. Once the scan is complete, Vault will list all the document files in the Advance steel documents 

folder. 

 The modified files will be listed in bold. 

 The unmodified files will not be bolded and the check in command will actually unlock 

the files on the server rather than checking in the ones on the local drive. 

 
h. Click Ok to finish the check in operation. Once the check in is done, all the drawings are checked 

back into the server. It is recommended to also check in the model (while keeping it checked 

out, if a user continues to work on it), so the latest version of the model, together with the 

updated drawings can be found on the server. 
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Method 2: Check out only the drawings that need to be updated 

a. Open the Vault client. 

b. Select and check out the drawing files (and their associated UPD files) for the documents that 

need an update. 

 
c. Update the drawings from Document Manager or manually from the drawing level. 

d. Use the Check In Folder command from the AutoCAD menu: 

 
e. In the Folder to Check In field browse to the Vault working folder – where the local copies of the 

Advance Steel files are stored. Select the Documents folder and click OK. Add a comment, if 

needed, for Vault workflow references (e.g. Assembly B1-3 section size changed). 
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f. Once the scan is complete, Vault will detect only the three drawings (and their UPD files) for 

check in. 

 

i. Click OK to finish the checking operation. Once checking is done, all the drawings are checked 

back in to the server. It is recommended to also check in the model (while keeping it checked 

out, if a user continues to work on it), so the latest version of the model, together with the 

updated drawings can be found on the server. 
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Notes on the workflow: 

 Why is it necessary the UPD files necessary to be added to Vault server, and then checked out 

for detail update? 

The .upd files in Advance Steel have an important role in the document management 

functionality of Advance Steel. They carry information about the update status of drawings, and 

minimize the amount of time Advance Steel needs to check for drawing status while launching 

the Document Manager, and the amount of data transferred during the update stage.  

Without the .upd files: 

o Advance Steel loses speed during update. 

o The status of the drawings in the Document Manager is inconsistent. 

If the UPD files are not checked out, or are ignored, the drawing will still be flagged for Update 

Required in Document Manager even after update; and after you save, close and reopen the 

model, Document Manager will list the respective drawing in the Unknown category, being 

unable to determine the state of the drawings. 

None of the model-drawing functionalities are affected, so even without the UPD files, you can 

update or revise the drawings, but their status will be unknown to Advance Steel. 

 

 Why is the Vault client used to check out drawing files for update instead of opening them 

with Advance Steel? 

When you open dwg files in AutoCAD from the Vault server, the automatic check out command 

is done only for the DWG file. Thus, this can be an alternative, but because the .upd file does 

not come as well together with the DWG file, the issues mentioned at the point above will occur 

and the drawing status in Document Manager will no longer be determined by the model.  

Using the Vault client for check out: 

o Allows the .upd file check out as well. 

o Permits a batch check out of multiple files through multi-selection commands. 

 Can the Vault client be used for check in? 

Drawings modified by AutoCAD – Advance Steel cannot be checked back in to Vault using the 

client. The drawings need to be checked back in through the application that was used to modify 

them – in our case Advance Steel. So the recommended workflow is to use the Check In 

command from inside the Vault AutoCAD add-in for checking the drawings back in. 

Updating drawings with Advance Steel revision control 

Advance Steel has its own revision control system. In order to work with Vault this system has been 

adjusted so as not to interfere with the Vault system - the file name does not change with a suffix 

revision mark,   but the revision I applied and logged in the Advance Steel system.  The attributes of the 

revision tokens are also registered and synchronized with the Vault system. 
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Workflow:  The general workflow to update with revision from Advance Steel, while using a Vault server 

to store the project, is done similarly to the ones mentioned above for drawing update. 

 Check out the detail drawing .dwg files together with their .upd files, from the Vault server (all 

at once or by selection). 

 Update using the Advance Steel Document Manager, in the 3D model. 

 Check files back in. 

An important aspect to take into consideration when working with Vault is that the files do not need to 

change their name. By default, Advance Steel changes the name of the detail drawings when applying 

revisions, but this functionality can be removed while still keeping the revision control – so new 

revisions are added to the drawings and all the other functionalities around this (revision table, balloon 

markings, etc.) remain functional. 

To prevent the file name change during Advance Steel revisions: 

1. Open the Advance Steel Management Tools. 

2. Access the Defaults tab 

3. Go to Revision control > General 

4. Modify the default called “Filename of drawing with a new revision index”  

o New Vault : %Filename 

 

Note:  The Advance Steel revision control functionality creates backup files. These backup files have two 

roles: 

1. To store a backup for each revision 

o This functionality is already available in Vault, where each file version is stored as a 

separate copy and can be accessed from the Vault client. 

2. To allow the creation of revision marking balloons, and keep them during other updates. The 

mechanism that adds the balloons needs the previous version for comparing, so the balloons 

are created only around the objects that were modified between two consecutive revisions.  

You can use both options so Advance Steel can be able to create its own revisions to keep the balloon 

marking mechanism in place.  



                                                                                                  Advance Steel Implementation Guide                                                                                                                   
 

138 
 

If the Advance Steel revision backup is turned on while using the Check In Folder command to check in 

any Advance Steel drawing modification or update, Vault will also add the backup files to the Vault 

server (which is recommended for consistency). 

To disable the Advance Steel automatic backup during revision update: 

1. Uncheck the Management Tools default called “Enable backup for revision control”, located in 

the Revision control > General category. 

 

This is a global setting, and it turns off the automatic backup for revisions for all projects created 

with Advance Steel. 

2. Alternatively, you can disable the automatic backup can on demand, during the Update with 

Revision command from Document Manager, by accessing the Backup tab in the Revision dialog 

and clearing the Make a backup option checkbox: 

 

Mapping the Advance Steel header attributes to the Vault internal attribute list 

Autodesk Vault is able to read, index and display attribute values from AutoCAD .dwg files inside Vault, 

which can be used to track revision, perform searches, create BoM lists or just for displaying more 

information about specific files. 

This functionality can be used together with the Advance Steel detail drawings, by reading the attributes 

Advance Steel uses to create the page header.  

To read and display the Advance Steel page attributes used in all Advance Steel drawings, you need to 

make modifications and mapping within the Vault server and client.  
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1. Add the Advance Steel page header block to the Vault indexing system on the server: 

 On the server side, open the  Autodesk Data Management Server (ADMS) Console 

 Go to Tools > Index Block Attributes…  

 
 Add the page header block internal name by using the New command. 

All the Advance Steel prototypes use the same block name to define the page header, where the 

attributes are evaluated automatically by Advance Steel during drawing creation. This block name 

cannot be changed, so this server side modification in Vault is done only once and then reused for all the 

Advance Steel projects processed through Vault. 

The block name is: HYPERSTEELPAGEHEADER 

 

 Force a re-indexing on the server side, if this change was done after some Advance Steel 

drawings were stored on the server.  

To do this: 

 Right click on Vault in the ADMS Console  

 Select Re-Index File Properties 
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 Check Force Re-Index at the bottom of the dialog. Filters can be applied (e.g. 

File Extension – DWG) to speed up the re-indexing process, for large Vault 

storages: 

 

2. The Advance Steel properties – attributes need to be mapped to Vault properties for further 

use. This is a client-only setting, and needs to be applied on each Vault client system that uses 

the Advance Steel project: 

 Open the Vault settings located in Tools > Administration. 
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 Open Properties in the Behaviors tab: 

 

 Use New to create a new property definition. This needs to be done for each Advance 

Steel page Header attribute. 

 

o Set the Name – this is a Vault property so it can have a different name than the 

Advance Steel attribute. 

o Type -> Text. 

o Set Associations on File and Base. 
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o Switch to the  Mapping tab and define a new mapping rule: 

 

o Set the Provider on AutoCAD (*.dwg, *.dwt): 
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o Click on the File Property field and choose Import Properties > Import from 

Vault. This command will prompt you to select a .dwg file, found in the Vault 

server. Select any Advance Steel detail drawing: 

 

o Once the Advance Steel detail drawing loads, the list will be populated with the 

attributes associated to the Advance Steel file.  

The Advance Steel specific attributes that display project-relevant values 

(Coating, Material, Project Number, Phase, etc.) will be listed under the name: 

HYPERSTEELPAGEHEADER.AttributeName. 

Note: Increase the Property column size to better view them in the list: 
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o Select one of them and conclude the mapping process and click OK to close the 

dialogs. 

Now the Vault attribute that was added is mapped to the Advance Steel attribute, so when used in Vault 

it will be able to read any value from the Advance Steel detail drawing. Once the detail drawing updates 

and this attribute changes, the Vault attribute will also change. 

Note: As those attributes are stored on the server, in order to update them in Vault, the Advance Steel 

detail drawing needs to be checked in to the Vault server first, after it was updated by the Advance Steel 

Document Manager.  

Advance Steel within Plant 3D Vault Workflow 

Embedding a new Advance Steel model into an existing Plant 3D project 

Create a Plant 3D Vault project, embed the Advance Steel model under the Plant Project Manager and 

register the model file into this folder structure. Use the Advance Steel model file within the Plant 

platform, continuing to use the normal Advance Steel operations available to the Advance Steel model 

when it is within its own platform, to complete modeling, create drawings and relative data files, and 

then check them in the same folder location in Vault. 

This maintains the Advance Steel operation within its own environment and enables the use of the 

Advance Steel model file within the Plant workspace, and, therefore, within Vault. This can also be Xref 

into various master and sub model locations. 

1. Starting in Plant 3D, you can create a new project directly in Vault or use an existing project 

from Vault. An important aspect of this workflow is the local path used to define the Plant 

project. This path is used as a local folder when the files are checked out for editing. You can 

configure this path, during the project definition as follows: 
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When the project is set up, the local folder on the hard drive for Plant 3D will be the following: 

 
 

In Vault, this project will be attached to “Root”. 

 

 
 

2. In the Plant 3D Project Manager, create a new folder for Advance Steel models. Typically, they 

are placed in the Plant 3D Models folder. 

 Right click on the Plant 3D Drawings folder, in the Project Manager and choose New 

Folder. 
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 Choose a name for the new folder and point to the Advance Steel Template files(.dwt) if 

needed: 

 
 

3. Right click on the newly created folder in the Project Manager for Advance Steel models and 

choose New Drawing. Fill in the name and click OK.  
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The Advance Steel model is created and will initially be located on the local drive, in the Plant 

project relative folder: 

 
 

4. To check in the newly created model in Vault, right click in the Plant Project Manager and 

choose Vault > Check In. Close the file in Plant after successfully checking in the model. 
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The file will appear in Vault, under the Plant project folder location: 

 
 

Configure the Vault client used by Advance Steel – AutoCAD with the Plant 3D project path 

Advance Steel connects to and uses the Vault file management system, using the generic Vault AutoCAD 

client. This is the reason why, in order to configure Advance Steel to work locally in the same folder as 

Plant, the settings need to be made inside the Vault client and not in Advance Steel. 

1. Open Vault Professional using the desktop shortcut: 

 
2. Go to File > Set Working Folder… 

 
3. Choose the root folder on the local machine where the Plant project is located. This folder is the 

same one as the one set in the Plant 3D project, when the project was created: 



                                                                                                  Advance Steel Implementation Guide                                                                                                                   
 

149 
 

 
 

4. Close the Vault Professional client and start Advance Steel. 

Log In to Vault if not set on automatic login. The Advance Steel Vault controls are available 

through the AutoCAD Vault Add-in that adds the new Vault ribbon tab when installed.  

 
 

 
 

5. Use the Open from the Vault command: 
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6. Navigate through the Vault structure and Plant project folders and the Advance Steel model 

created in the previous step: 

 
 

 
 

7. When opening the Advance Steel model, Vault will prompt a message saying that the file is not 

checked out: 

 
Note that the path the Vault client under Advance Steel is trying to check out the file from is the 

same as the one the Plant project uses on the local computer to work. 

 
 

8. Create the Advance Steel model. 

At any point of the model generation, you can check in the model into Vault, using the Check In 

button located on the Vault ribbon in Advance Steel. 
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9. Once the work is done in Advance Steel and the model is ready to be loaded in Plant: 

 Save the model and use the Check In command. 

 Close the file from Advance Steel. 

 

10. Go back to Plant 3D Project Manager and refresh the Vault Advance Steel model. To refresh the 

model, right click on the file and choose Vault > Refresh from Vault. 
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Once refreshed, open the model. The model will open and will be displayed correctly in Plant 

3D: 

 
 

11. Continue your work using the Vault workflows. 

 A file can be checked out by one user only. 

 Because both Advance Steel and Plant 3D use the same working folder on the hard 

drive, make sure that the file is open in only one of the two software. The file should be 

open in the software where the check-out is done and the customer works on the file. 

At this point the file is located in the same local folder on the hard drive and also in the same local drive 

in the Vault structure. 

 

Local working folder for both Advance Steel and Plant 3D 
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Vault location 

 

Notes about the Vault working folder 

The way the Vault Professional client working folder works is similar to how the Plant 3D project 

manager sets the working folder during the project creation. 

If both folders match, Plant 3D and Advance Steel will use the same local drive path to check in, check 

out and use files. 

The working folder is set inside the Vault Professional client and not in Advance Steel because Advance 

Steel connects to Vault through a generic application, integrated in AutoCAD. Also, Plant 3D has a 

dedicated connection to Vault (it also uses the Vault client, but it provides an additional level of 

configuration) which allows the use of a different local folder.  

To easily deploy the same configurations for all users within a company that connect to the same Vault 

storage with Plant projects, you need to: 

 Store each Plant 3D project in the root location of the Vault storage. 

 Place all projects in the additional folder on the Vault storage (if one is used) – e.g. Plant Projects 

- so that in their relative path, the root remains constant ($:/Plant Projects/……)  

At this point: 

 Opening the project in Plant 3D will create the same relative working folder on the drive for 

each user: 
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The folder is then used to download all the Plant 3D projects from the Vault server. 

 

 The folder created by Plant 3D needs to be set as Working Folder in each user’s Vault 

professional client. This allows Advance Steel to work in the same folder as Plant 3D: 

 

Handling the Advance Steel model and drawings in a typical Advance Steel – 

Plant 3D – Vault environment 

The Plant 3D model together with all the Plant deliverables are handled using the Plant Project 

Manager, connected directly to Vault. 

The Advance Steel model is connected to Vault through the Plant Project Manager, but the ability to 

Check In/Check Out the model in Vault is also available in Advance Steel. Checking the model through 

Advance Steel will update its status in the Plant Project Manager, giving the user feedback about the 

status of the model.  

Updating the Advance Steel model will be highlighted in the Plant 3D project, if using Xref to reference 

the two models. 
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All Advance Steel drawings are produced and handled independent from the Plant 3D project, using the 

same workflow as the one described in the previous chapter. They exist in the same Vault project 

location on the server, and are copied and used locally from the same folder on the user drive (using the 

correct configuration of the Working Folder in the Vault client, to match the Plant 3D working folder for 

the same project). 

 

Conclusion 
This concludes the Advance Steel Implementation Guide. Please use the Autodesk Knowledge Network 

to ask questions or provide feedback. 

https://knowledge.autodesk.com/community

